This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable agreement between you and Oracle.

The business names used in this documentation are fictitious, and are not intended to identify any real companies currently or previously in existence.
# Contents

## Preface

## Overview

- About This Guide
- Creating and Administering HCM Analytics and Reports: Overview
- Securing HCM Analytics and Reports: Overview
- Do I need to create copies of predefined reports and analyses for each user?
- Viewing Analytics and Reports
- How can I find analytics and reports?
- Reports and Analytics Work Area and Panel Tab: Explained
- Business Intelligence Catalog: Explained
- Saving Analytics and Reports: Points to Consider
- What Happens to Modified Analytics and Reports When an Update Is Applied?
- Setup and Administration Overview
- Oracle Business Intelligence: Highlights

## Setup and Configuration

- Mapping to Work Areas
- Setting Up Currency
- Configuring Business Intelligence Publisher
- Setting Up the Delivery Channel

## Subject Areas

- Data Structure for Analytics: Explained
- Why do I get a list of all legal employers instead of only one when I create a report?
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Flexfields</td>
<td>23</td>
</tr>
<tr>
<td>Configuring Flexfields for Use in Analyses: Overview</td>
<td>23</td>
</tr>
<tr>
<td>Configuring Key Flexfields for Transactional Business Intelligence</td>
<td>23</td>
</tr>
<tr>
<td>Configuring Descriptive Flexfields for Transactional Business Intelligence</td>
<td>28</td>
</tr>
<tr>
<td>Configuring Extensible Flexfields for Transactional Business Intelligence</td>
<td>29</td>
</tr>
<tr>
<td>Importing Changes to Flexfields Automatically</td>
<td>31</td>
</tr>
<tr>
<td>Disabling Flexfields as BI-Enabled</td>
<td>32</td>
</tr>
<tr>
<td>Dimensions Supported by Descriptive Flexfields</td>
<td>34</td>
</tr>
<tr>
<td>Human Capital Management Descriptive Flexfields for Oracle Transactional Business Intelligence</td>
<td>34</td>
</tr>
</tbody>
</table>

| 5 Analytics Modification | 41 |
| Creating and Editing Analytics: Highlights | 41 |
| Analyses | 41 |
| Cross-Subject Area Joins | 45 |
| Reporting for HCM as of a Specific Date: Explained | 46 |
| Cross-Subject Area Analyses | 46 |
| Dashboards | 48 |
| Configurable Email Notifications | 49 |
| FAQs for Analyses and Dashboards | 86 |

| 6 Reports Modification | 89 |
| Oracle Business Intelligence Publisher: Overview | 89 |
| Style Templates: Explained | 89 |
| Subtemplates: Explained | 90 |
| Creating and Editing Reports: Explained | 91 |
| Accessing Report Components to Modify: Points to Consider | 92 |
| Using the Customize Option for Predefined Reports: Points to Consider | 93 |
| Links Between Original and Modified Reports: Points to Consider | 94 |
| Layouts | 95 |
| Data Models | 101 |
| Creating a New Data Model for an HCM Report: Worked Example | 102 |
| New Reports | 103 |
7 Analytics and Reports Management

Managing Folders ........................................................................................................ 107
Using Briefing Books .................................................................................................... 108
Scheduling Analytics and Reports .................................................................................. 109
Adding Analyses to Application Pages .......................................................................... 112

8 Maintenance and Migration

Performance Tuning for Analytics and Reports: Points to Consider .......................... 115
Reviewing SQL Statements Used in Analyses: Procedure ........................................ 115
Moving Analyses and Reports: Procedure .................................................................. 116
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons 📘 to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Guides and Videos**: Go to the Oracle Help Center to find guides and videos.
- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
Chapter 1
Overview

About This Guide

This guide is intended for advanced users and administrators who want to modify and create analytics and reports, as well as perform setup and maintenance tasks for business intelligence. The guide contains both conceptual and procedural information intended to help you build and manage analyses, reports, and dashboards that are tailored to the content needs of your line of business or company. You can also use the information in this guide to help you set up business intelligence.

Creating and Administering HCM Analytics and Reports: Overview

The predefined analyses, dashboards, and reports help you meet business intelligence requirements. You might want to edit them or create ones for your own purposes. If you have the appropriate roles, you can modify analytics and reports and make them available for use by others.

Setup and Administration

Several tasks exist that support creating and editing analytics and reports. For example, an implementor or administrator can:

- Secure access to customer-defined analytics and reports.
- Archive and move customer-defined analytics and reports from one environment to another.

For more information about security tasks, see Oracle Applications Cloud: Administering Analytics and Reports

Related Topics

- Creating and Editing Analytics: Highlights
- Creating and Editing Reports: Explained

Securing HCM Analytics and Reports: Overview

All users with appropriate roles can create and access analyses and reports based on role access to subject areas and catalog folders.

Analyses and reports are secured by applying job roles with associated duty roles to users. Duty role assignments determine access to subject areas for analyses as well as catalog folders. For information about the job and duty roles provided with HCM, and how to modify your security model by creating your own job roles and assigning duty roles to them, see the HCM Security Guide.
Do I need to create copies of predefined reports and analyses for each user?

You don’t need to create multiple versions of the same analysis or report for different users. When you view an object, it includes only the data that you have permission to view from your data security profile. In analyses and reports with hierarchical dimensions, you see information from your level in the hierarchy and downward in the hierarchy.

Viewing Analytics and Reports

How can I find analytics and reports?

See if the analysis or dashboard already appears on your page, perhaps on a separate tab. Or there might be, for example, a link to the report you want to use. Also look for the Reports and Analytics pane, which may appear on your work area as a panel tab or in the regional area. In the pane, you find analytics and reports specific to the work area you’re on.

To see all the analytics and reports that you have access to, use the Reports and Analytics work area (Navigator > Tools > Reports and Analytics).

Reports and Analytics Work Area and Panel Tab: Explained

Navigate to and search for analytics and reports in the Reports and Analytics work area and panel tab. The Reports and Analytics work area provides access to all the analytics and reports in the Business Intelligence (BI) catalog you own or have permissions for. The Reports and Analytics panel tab provides access to BI catalog content relevant to work areas where it appears. If you have appropriate roles, you can specify which reports appear in a specific work area.

Reports and Analytics Work Area

The Reports and Analytics work area is a central place for you to quickly search for and run analytics and reports that are related to your work. The work area (Navigator > Tools > Reports and Analytics) opens at the highest level of the business intelligence (BI) catalog’s folder hierarchy with all objects you have marked as favorites.

- Search the catalog by object type and name, or use saved searches.
  a. Optionally, select an object type in the list to search for analyses, reports, or dashboards.
  b. Enter a name or part of a name and click Search. Select from the saved searches, including Favorites and Recent Items, to quickly access frequently used objects.
  c. Optionally, click Add Favorites for an object to mark it as a favorite.
- View and edit analyses and reports.
• Navigate the catalog’s folder hierarchy using the folder breadcrumb.
  a. Click the Hierarchical Selector for All Folders and select My Folders or Shared Folders to begin navigating the catalog folder contents.
  b. Click a folder in the folder breadcrumb or the results to navigate to it.
  c. Click the Hierarchical Selector within the folder breadcrumb to navigate to a parent folder and select one of its subfolders in the catalog.

• View your favorite analyses and reports and mark objects as favorites.
  a. Select Favorites in the Saved Searches to display your favorite objects.
  b. Click Add Favorites for an object to mark it as a favorite.
  c. Click Remove from Favorites to remove an object from your favorites.

• Create and edit analyses and reports.
  a. Click Create and select Report or Analysis.
  b. Use wizards to create your analysis or report.

• Click an object’s path to navigate to its catalog folder.
• Click an object’s name to open it.
• Click Browse Catalog to open the catalog in Oracle Business Intelligence.

Reports and Analytics Panel Tab
You may find the Reports and Analytics panel tab on some work areas. Click the Reports and Analytics icon to open the panel tab. If you have permission, you can create analyses and reports by clicking Create and selecting an object. Open the folders to view mapped analyses and reports for the work area, and click their names to view details and to open or edit them.

Available Catalog Folders
This table describes what’s in the folders of the Reports and Analytics work area and panel tab.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Folders</td>
<td>All of the analyses and reports that you saved for your own use only.</td>
</tr>
</tbody>
</table>
| Shared Folders | • Reports and Analytics work area: all of the analyses and reports that you have permissions to access, including any in the Custom subfolder. Place your shared analyses and reports in the Custom folder to protect them during upgrades.  
 |              | • Reports and Analytics panel tab: All predefined analyses and reports that are relevant to your role and have been mapped to the work area. |

Related Topics
• Setting Up the Reports and Analytics Panel Tab: Procedure
• Viewing Analytics and Reports: Procedure
• Creating and Editing Analyses Using a Wizard: Procedure
• Creating and Editing Reports: Explained
Business Intelligence Catalog: Explained

Reports, analyses, dashboards, and other business intelligence (BI) objects are stored and administered in the business intelligence catalog.

Navigating to the Catalog

To navigate to the catalog:

1. Click **Tools > Reports and Analytics** in the Navigator.
2. In the Reports and Analytics work area, click the **Browse Catalog** button.

Identifying Objects in the Catalog

The catalog stores the BI objects in a folder structure of individual files, organized by product family.

BI objects and reports are organized in the following folder hierarchy:

- Shared Folders (parent)
- Product family (example: Financials)
- Product (example: Payables)
- Report groups (example: Invoices)
- Dashboard reports
- Data Models
- Report Components
- BI Publisher reports
- Prompts

The following table describes the common BI objects that you find in the catalog:

<table>
<thead>
<tr>
<th>Catalog Object</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>Analyses are used primarily by dashboards.</td>
<td>Report Components folder</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Dashboards organize analytical content and catalog objects, and present them in a meaningful way.</td>
<td>Reporting group folder</td>
</tr>
<tr>
<td>Dashboard Prompt</td>
<td>Dashboard prompts allow users to filter dashboard content using provided values.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters are used in dashboards and analyses.</td>
<td>Prompts folder</td>
</tr>
<tr>
<td>Catalog Object</td>
<td>Description</td>
<td>Location</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Report</td>
<td>Reports are operational reports created in Business Intelligence Publisher.</td>
<td>Reporting group folder</td>
</tr>
<tr>
<td>Data Model</td>
<td>Data models are used by reports created in Business Intelligence Publisher.</td>
<td>Data Models folder</td>
</tr>
<tr>
<td>Subtemplate</td>
<td>Subtemplates are used by reports created in Business Intelligence Publisher.</td>
<td>Reporting group folder</td>
</tr>
</tbody>
</table>

**Saving Analytics and Reports: Points to Consider**

You save analyses, dashboards, and reports in the business intelligence (BI) catalog, along with other objects, including prompts and filters. The catalog has a hierarchy of folders, starting with My Folders and Shared Folders. One important folder is Custom, which you find under Shared Folders and use to store your modified analytics and reports.

**My Folders**

You’re the only one who can access anything that you save in My Folders. You can see your saved items in My Folders on the Reports and Analytics work area, but not in My Folders in the Reports and Analytics panel tab on any other work area. The only exception is when you create an analysis using the wizard in the Reports and Analytics work area, and save it in My Folders. In this case, the analysis is available in any panel tab on all work areas.

**Shared Folders**

If you have the appropriate roles, you can also save in Shared Folders so that your modified analytics or reports are available to anyone with the right access. You should save objects under the Custom subfolder, which has subfolders organized by product family.

Regarding predefined analytics and reports in Shared Folders:

- You should save a copy of the predefined analysis or dashboard in the corresponding product family subfolder under the Custom folder, and edit only the copy. Directly edit predefined analytics only when necessary, to make sure that any references to the analysis or dashboard still work properly.
- For predefined reports only, you can use a special Customize option to copy the report and also the folder structure and permissions. The copy is linked to the original, so editing the copy is like directly editing the original.

**Custom Folder**

Keep all modified analytics and reports in the Custom folder so that:

- You ensure that modified copies of those objects are not affected during upgrades, which can change predefined analytics and reports outside the Custom folder. You might lose changes saved outside the Custom folder during upgrades.
- You can easily find modified objects.
- You can edit objects in the Custom folder without compromising security on the original objects.
When you copy an object into the Custom folder, the copied object inherits the permission settings of the Custom folder. An administrator can reset the permissions on the object and the folder that it’s in.

Related Topics

- Creating and Editing Reports: Explained
- Creating and Editing Analytics: Highlights
- Using the Customize Option for Predefined Reports: Points to Consider

What Happens to Modified Analytics and Reports When an Update Is Applied?

When saved in the Custom subfolder within Shared Folders, or in My Folders in the business intelligence (BI) catalog, modified analytics and reports are preserved during an update. Any modified objects in the Custom folder are preserved in any update. Changes to existing analytics and reports outside the Custom folder, including those you create, are preserved only if the update doesn’t include a new version of those BI objects. If the update includes a new version of a predefined object that you edited outside the Custom folder, then:

- The new version overwrites the existing predefined object.
- A copy of the existing object (with your edits) is automatically created in the same folder, with a new name that indicates it’s a new version.

If the update includes a new version of both the predefined object and a folder in its file path, then:

- The new folder, along with the new version of the object, overwrites the existing predefined folder and object.
- A copy of the existing folder (along with your edited object) is automatically created. The folder is renamed to indicate that it’s a new version, but your edited object is not renamed.

Note: Future updates won’t affect renamed objects or anything within a renamed folder.

Setup and Administration Overview

Tools for Administering Analyses and Reports: Explained

You can use several different tools to manage and administer analyses and reports.

These components support modification and administration of your analyses and reports:

- Use the Business Intelligence catalog to interact directly with your reports and analyses. Use this interface to manage permissions, properties, and the organization of your analyses and reports.
- Use the Oracle Business Intelligence Publisher administration pages to configure settings specific to the running and scheduling of operational reports, such as setting up your delivery servers, managing scheduler work load, and setting run-time properties for reports.
Define Transactional Business Intelligence Configuration: Overview

Use the Define Transactional Business Intelligence task list in the Setup and Maintenance work area to complete configuration of business intelligence in your application. Some tasks in this task list are performed during Oracle Applications Cloud provisioning and require no further action from you. The Define Transactional Business Intelligence Configuration task list includes the following tasks:

- **Optimize Transactional Business Intelligence Repository**
  
  Trim unused projects from the business intelligence repository based on configured Oracle Applications Cloud offerings. This optimization is automated during the provisioning process and requires no further action from you.

- **Manage Transactional Business Intelligence Connections**
  
  Review data source connections in the physical layer of the business intelligence repository. Connections are set up and reviewed during the provisioning process, and this task requires no further action from you.

- **Manage Security for Transactional Business Intelligence**
  
  Review security for business intelligence users. The default security configuration can be modified. Refer to the security documentation for your cloud services to review or change the default user security model.

- **Configure Key Flexfields for Transactional Business Intelligence**
  
  Define the key flexfield segments and validation for use as classification keys. You must define these key flexfields for Oracle Fusion Transactional Business Intelligence to operate correctly.

- **Configure Descriptive Flexfields for Transactional Business Intelligence**
  
  Define validation and display properties of descriptive flexfields, which are used to add attributes to entities. You enable and import flexfields for use in analyses.

- **Import Essbase Cubes into Transactional Business Intelligence Repository for Financials General Ledger**
  
  Import Essbase cubes into the business intelligence repository. You must perform this task if you’re using Oracle Fusion General Ledger.

- **Manage User Currency Preferences in Transactional Business Intelligence**
  
  Manage user currency preferences, which control regional currency settings, currency used in reports, and corporate currency.

**Related Topics**

- Essbase Rule File and Cubes: Overview
- Configuring Flexfields for Use in Analyses: Overview
- Configuring Descriptive Flexfields for Transactional Business Intelligence: Overview
- Importing Flexfield Changes: Overview
- Setting Currency Preferences for Analytics: Overview
Oracle Business Intelligence: Highlights

Business intelligence analytics and reports in the application are provided by the Oracle Business Intelligence Enterprise Edition suite. You can access many information sources about working with Oracle Business Intelligence Enterprise Edition.

The information resources cover the following areas:

- Oracle Business Intelligence Enterprise Edition
- Oracle Business Intelligence Publisher

Oracle Business Intelligence Enterprise Edition

Oracle Business Intelligence Enterprise Edition provides predefined and ad hoc analysis against your transactional data.

- Create and work with analyses, dashboards, and advanced analytical content, including dashboard prompts, conditions, actions, and key performance indicators.

  See: Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Enterprise Edition

Oracle Business Intelligence Publisher

Oracle Business Intelligence Publisher is used for reports.

- Run and view reports.

  See: Oracle Fusion Middleware User’s Guide for Oracle Business Intelligence Publisher

- Create and edit reports, layouts, and templates and subtemplates.

  See: Oracle Fusion Middleware Report Designer’s Guide for Oracle Business Intelligence Publisher

- Create data models and use the Data Model Editor.

  See: Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher
2 Setup and Configuration

Mapping to Work Areas

Setting Up the Reports and Analytics Panel Tab: Procedure

You can find the Reports and Analytics panel tab in many work areas, and the analytics and reports you see in it depend on the work area. You can define what’s available for a specific work area, by mapping reports from the business intelligence (BI) catalog to that work area. In this mapping context, reports refer to both analytics and reports. Your changes apply to all users who have access to the work area you’re mapping.

Mapping Reports from Your Work Area
To map reports to the work area that you’re in:

1. Expand the Reports and Analytics panel tab.
2. Click the Edit Settings icon in the panel tab.
   
   You see all the reports that are currently mapped to your work area.
3. Click Select and Add.
4. Find the report in the catalog and select it.
5. Click OK.
6. To remove any mapping, select the report and click Remove.
7. Save your work.

Mapping Reports to Any Work Area
To map reports to any work area that you have access to:

1. Go to the Setup and Maintenance work area and open the Map Reports to Work Areas task.
2. Select the application of the work area you want to map to.
3. Select the work area.
4. Click Search and see all the reports that are currently mapped to that work area.
5. Click Select and Add.
6. Find the report in the catalog and select it.
7. Click OK.
8. To remove any mapping, select the report and click Remove.

Tip: Click Synchronize to remove all mappings to any reports that are no longer in the catalog. You synchronize all work areas, not just the one you’re mapping.

9. Save your work.

Related Topics
• Setting Reports Up for Scheduling: Procedure
• Reports and Analytics Work Area and Panel Tab: Explained
Why can't I see reports when mapping reports to work areas for the Reports and Analytics panel tab?

Either no reports are currently mapped to the work area you select on the Map Reports to Work Areas page, or you don't have access to the reports that are mapped.

Similarly, when you’re selecting a report to map, you can see only the reports that you have access to. Ask your administrator to either:

- Assign you roles that have access to the reports you want to map to work areas.
- Grant the Reports and Analytics Region Administration Duty to someone who already has access to those reports.

Why can't I see reports when I edit settings for the Reports and Analytics panel tab?

In the Edit Settings window, you might not see a currently mapped report because you don't have access to it.

Similarly, when you’re selecting a report to map, you can see only the reports that you have access to. Ask your administrator to either:

- Assign you roles that have access to the reports you want to map to work areas.
- Grant the Reports and Analytics Region Administration Duty to someone who already has access to those reports.

Setting Up Currency

Setting Currency Preferences for Analytics: Overview

Oracle Transactional Business Intelligence gives you the ability to set your personal currency preferences, as well as set currency preferences which determine how your analyses display currency and calculate exchange rates.

The user preferences for your cloud offering are set in the cloud environment, and the currency preferences for analyses are set in Oracle Business Intelligence (BI). Both user preferences impact how your report currency is calculated and displayed. Your application administrator sets the corporate currency as the common currency basis for all users.

There are three ways currency is set in cloud and BI environments:

- **User Currency** - Set by the business user in Regional settings. This setting applies to the entire application interface for that user only. The currency options available are set by your application administrator.

- **Reports Currency** - Set by the business user in BI in My Account settings in the Reports area. The setting applies to that user only and only relevant for report production.

- **Corporate Currency** - Set by the application administrator. This setting applies to all users in that company.
Setting Your General User Currency: Explained

User currency settings govern the currency that is used as the default for your application interface. User currency is set in the application and applies to your entire interface for your signed-in session.

To set your user currency:

1. Navigate to Tools, Set Preferences.
2. Select General Preferences > Regional.
3. Select the preferred currency to be used. Available currencies include those set up for your company by your application administrator.

Setting Your Personal Analysis Currency

The analysis currency determines the currency that is used in reports and analyses. It also determines how and when your currency conversion rates are calculated.

To set your currency for reports and analyses:

1. Navigate to Business Intelligence.
2. Click Analytics in the navigator menu.
3. Click Browse Catalog.
4. Click your user name and and select My Account.
5. Go to the Preference.

The following table describes the currency menu options.

<table>
<thead>
<tr>
<th>Currency Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entered Currency</td>
<td>Currency used on a transaction.</td>
</tr>
<tr>
<td>&lt;Application&gt; Currency</td>
<td>Currency set up in each respective Cloud application as the common Corporate currency used company-wide.</td>
</tr>
<tr>
<td>User Preferred Currency using Simple Currency Management</td>
<td>Conversion to User Preferred Currency is performed at the time your run the report, and is calculated from the Corporate currency based on the last time the record was updated and saved or closed.</td>
</tr>
<tr>
<td>User Preferred Currency using Advanced Currency Management</td>
<td>Conversion to User Preferred Currency happens on the date your run the report, and uses the currency indicated on the record.</td>
</tr>
</tbody>
</table>

Setting a Default Currency Conversion Option for All Users: Explained

The default setting for the way currency conversion is handled for analytics is the User Preferred Currency Using Simple Currency Management. This simple currency management setting provides the best run-time performance when dealing with currency exchange rate management. But there are cases when your organization might want to standardize the setting for all system users, by setting the default preference to another option, such as CRM Currency or User Preferred Currency Using Advanced Currency Management.
To change the default currency setting for all users, administrators need to add a profile option and a corresponding value. Note that when administrators change the default currency setting for users in their organization, individual users can still override that setting and select their preferred currency in My Account.

The following table shows the profile option code parameters to override the default currency setting.

<table>
<thead>
<tr>
<th>Profile Code</th>
<th>Profile Value Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BI_DEFAULT_CURRENCY_CONVERSION_METHOD</strong></td>
<td>CRM Currency - Defaults to Application Currency.</td>
</tr>
<tr>
<td></td>
<td>User Preferred Currency 1 - Defaults to User Preferred Currency Simple Currency Management.</td>
</tr>
<tr>
<td></td>
<td>User Preferred Currency 2 - Defaults to User Preferred Currency Advanced Currency Management.</td>
</tr>
</tbody>
</table>

Adding a Currency Profile: Explained

To set default global currency conversion types for all users, administrators create a currency profile. Currency profiles are added in Setup and Maintenance, one of the options available when you click your user name in the Home Page. Only administrators can change global currency preferences by creating profiles.

To **Add** a currency profile:

1. Go to **Setup and Maintenance**.
2. Search for Manage Profile Options.
3. Click the + (New icon) in Search Results: Profile Options.
4. Enter the following values:
   - **Profile Option Code**: BI_DEFAULT_CURRENCY_CONVERSION_METHOD
   - **Profile Display Name**: BI Default Currency Conversion Method
   - **Application**: Application
   - **Module**: Module
   - **Start Date**: Provide previous day’s date to proceed to next step to define values.
5. Click **Save** and **Close**.
6. In the Manage Profile Options dialog, you see your new profile. Check the Enabled box for Site.
7. Click **Save** and **Close**.

Defining Currency Profile Values: Explained

Once you have created your currency profile, the last step is to define the profile value. This step defines which currency management option is assigned to that profile.

To define a currency profile value:

1. Go to Setup and Maintenance.
2. Search for "Manage Administrator Profile Values".
3. Click Manage Administrator Profile Values.
4. In Profile Option Code search for your profile: BI_DEFAULT_USER_CURRENCY.
5. In Manage Administrator Profile Values, Click + (Add icon).
6. Select Site as the Profile level.
7. Enter "User Preferred Currency 2" in Profile Value.
8. Click Save and Close to close the dialog.

User-Preferred Currency Reporting and Exchange Rates: Points to Consider

The simple and advanced user-preferred currency choices determine how and when your currency exchange rates are calculated for your reports. For both simple and advanced currency management, when you save or close a report, the application sets the exchange rate at that time. The option you choose impacts how quickly your reports are generated at run time. Each case includes trade-offs, as detailed in the examples.

User Preferred Currency using Simple Currency Management

The advantage of this option is performance - the application doesn't have to look up the rate for each transaction because when you close or save a record, the application converts it to your corporate currency at that day's rate. When you run the opportunity report, the application multiplies that value by your preferred currency exchange rate for the date you run the report. This eliminates the need for the application to cycle through each record, and calculate the corresponding exchange rate to your preferred exchange rate at the time that record was closed or last saved. It simply takes the value on record for the original transaction exchange to corporate currency, and multiplies it by your preferred currency exchange rate at the time your run the report.

As an example of user preferred currency using simple currency management, a user updates and saves or closes an opportunity record with associated revenue of one million Indian Rupees on January 31st with an exchange rate of 0.01403 Rupees to one US Dollar. The user then runs an opportunity report in US Dollars on March 31st. In the report, the US Dollar Corporate Currency is set at the January 31st rate it was saved at, in this case reporting as $14,030, or one million multiplied by 0.01403. Finally, an opportunity report on March 31st in Euros uses the March 31st conversion rate for US Dollars to Euros of 0.75017 to convert the recorded US Dollar amount into Euros, in this example one million multiplied by 0.1403, which is the January 31st Rupee to US Dollar exchange rate, multiplied by 0.75013, which is the March 31st rate for Euros. This requires less processing, because the January 31st Rupee to US Dollar exchange rate, while not exact on March 31st, is used as the basis for the calculation of the March 31st opportunity revenue conversion to Euros at the later exchange rate.
The following figure describes an example of user preferred currency using simple currency management.

**Example of User Preferred Currency using Simple Currency Management:**

- **User updates and saves or closes record on January 31st**
  - **Opportunity Currency in INR = 1M**
  - **Jan 31st, 2014 exchange rate: INR to USD = 0.01403**

- **User runs opportunity report on March 31st**
  - **Corporate Currency in USD is set at the Jan 31st 1M INR converted to USD at the exchange rate when closed or saved, in this case x 0.01403 = $14030**

- **Opportunity report on March 31st shows all opportunities in EUR**
  - **User Preferred Currency in EUR is shown in report as March 31st 2014 rate USD to EUR at March 31 rate 0.75017 = EUR 10517 (1M x 0.1403 x 0.75017)**

**User Preferred Currency using Advanced Currency Management**

This option provides a more precise exchange rate, since it goes through each record to determine the rate on the date the record was updated or closed. The downside of this option is performance. Your reports will take longer to run. The application has to cycle through each record and match currency exchange rates to the date the record was closed or updated and saved.

As an example of user preferred currency using advanced currency management, a user updates and saves or closes an opportunity record with associated revenue of one million Indian Rupees on January 31st, when an exchange rate of 0.01050 Rupees to one Euro applies. The user then runs an opportunity report on March 31st. In the report, the User Preferred Currency of Euros is applied, using the March 31st Rupee to Euro rate of 0.01052, requiring calculation during report processing to resolve the opportunity to 10,520 Euros. Finally, an opportunity report on March 31st in Euros again uses the March 31st conversion rate for Euros.
The following figure describes an example of user preferred currency using advanced currency management.

Example of User Preferred Currency using Advanced Currency Management:

User updates and saves or closes record on January 31st

User runs opportunity report on March 31st

Opportunity report on March 31st shows all opportunities in EUR

User Preferred Currency is EUR. Exchange rate for INR to EUR on March 31st is 0.01052 = EUR 10520

Exchange Rates
Jan 31st, 2014 rate: USD -> EUR = 0.75011
Jan 31st, 2014 rate: INR -> EUR = 0.01050
Jan 31st, 2014 rate: INR -> USD = 0.01401
Mar 31st, 2014 rate: INR -> EUR = 0.01052
Mar 31st, 2014 rate: INR -> USD = 0.01403

Why do I see amounts of zero in analyses?
The currency exchange rates might not be set up correctly. For example, you choose EUR as your preferred currency in general preferences, and your corporate currency is USD. Amounts in analyses are displayed in EUR after conversion from USD, based on the current exchange rate. But if the exchange rate between EUR and USD isn’t set up, or if the conversion fails for any reason, then the amounts show as zero. If this happens, contact your help desk.

Configuring Business Intelligence Publisher

Managing Report Delivery Servers: Overview

Oracle Business Intelligence Publisher, the report generation and delivery engine, requires configuration and tuning to deliver reports to users.

Report requests are received by Publisher from:

- Oracle Enterprise Scheduler
The Reports and Analytics work area and panel tab

Application pages

Requests submitted through Oracle Enterprise Scheduler are processed by the Oracle BI Publisher scheduler. Requests submitted through the Reports and Analytics work area or panel tab can be either real-time online requests or scheduled requests. Requests submitted through an application may call Oracle Enterprise Scheduler or may return report request results directly back to the application page.

Oracle BI Publisher is configured to accept requests from Oracle Applications Cloud. However, before you can deliver report documents to their destinations, you must define the delivery servers in Oracle BI Publisher. Use the Oracle BI Publisher Administration page to define your delivery servers.

Once delivery servers are defined, you can further configure the number of report processor and delivery threads to best handle your processing and delivery requirements. In addition, you can configure report properties for the delivery servers or at the report level to tune performance of your reports. To diagnose report processing issues, BI Publisher provides a set of scheduler diagnostics.

Navigating to the Oracle BI Publisher Administration Page: Procedure

You use the Oracle BI Publisher Administration Page to perform most tasks related to report delivery and performance.

Use the Oracle BI Publisher Administration page to:

- Configure delivery servers
- Manage report and delivery processors
- View scheduler diagnostics
- Set system properties and report runtime configuration properties

Request the Oracle Applications Cloud security administrator to assign the BI Platform Administrator duty role (BI stripe) to the person responsible for administering BI analyses, dashboards, and BI Publisher reports. Administration tasks include security permissions for objects, organizing objects into folders, accessing log files, and several other tasks.

Navigating to the Administration Page

To navigate to the Oracle BI Publisher Administration page:

1. Click **Tools > Reports and Analytics** in the Navigator.
2. In the Reports and Analytics work area, click **Browse Catalog**.
3. In the Catalog page, click **Administration**, then click **Manage BI Publisher**.

Configuring Report Delivery Servers: Procedure

Set up the report delivery servers to support printing.

**Configuring Servers**

To configure delivery servers:

1. From the BI Publisher Administration page, click **Delivery Configuration**.
2. Enter values in the Delivery Configuration Options tab to set general properties for email deliveries and notifications.
3. To configure a delivery server, click the appropriate tab.
Understanding the Report and Delivery Processors: Overview

When Oracle Enterprise Scheduler initiates a job, it is picked up by the BI Publisher scheduler queue.

- **Job Processor:** Listens for requests from the scheduler queue. When the job information is received, the job processor executes the data model (and splits the data for bursting jobs), stores the data in the shared temporary folder, and sends the report metadata to the report queue.

- **Report Processor:** Listens for requests from the report queue. When the report information is received, the report processor generates the report documents, stores it in the shared temporary folder and puts the delivery information in the delivery queue.

- **Delivery Processor:** Listens to the delivery queue and handles the delivery of reports for its channel. The delivery processors are:
  - Email Processor
  - File Processor
  - FTP Processor
  - Print Processor
  - WebDAV Processor
  - Fax Processor

Managing Report Processing and Delivery Server Load: Procedure

Manage the processors in the BI Publisher Scheduler Configuration page.

**Managing Processing and Server Load**

By default, each processor is enabled and the thread count for each is set to five. For each managed server that is running in the BI cluster, a table for that instance’s processors is displayed. Use the table to enable or disable processors for the instance and configure the thread counts.

To configure processor threads:

1. From the BI Publisher Administration page, click **Scheduler Configuration**.
2. In the Cluster Instances region of the Scheduler Configuration page, enter the Number Threads value in the processor configuration table.
3. All processors are automatically set to use the number of threads defined in the Threads Per JMS Processor value of the JMS Configuration region of the page. Enter a value in the Number Threads column to change the value from this default.

After performing the scale-out procedure, configure the processor threads for each cluster instance using the same steps.

Diagnosing Report Processing Issues: Procedure

The Scheduler Diagnostics page provides the runtime status of the scheduler. Among others, it provides status of its JMS configuration, JMS queues, cluster instances, scheduler Database, and Oracle Enterprise Scheduler.
Diagnosing Issues

To access the Scheduler Diagnostics page:

1. Navigate to the Oracle Business Intelligence Publisher Administration page.
2. In the System Maintenance group, click Scheduler Diagnostics.

Configuring System Properties for Reports: Procedure

Use the Oracle BI Publisher Runtime Configuration page to set the system-level runtime properties for reports.

Configuring Reporting Properties

To access the Runtime Configuration page:

1. Navigate to the Oracle Business Intelligence Publisher Administration page.
2. In the Runtime Configuration group, click Properties.

Changing Memory Guard Settings: Procedure

Memory Guard settings for Oracle BI Publisher have default settings optimized for performance. To change Memory Guard settings from the defaults, log a service request with details in the Memory Guard request template.

Reviewing Memory Guard Settings

To Review Memory Guard Settings:

1. Click Properties.
2. Click Manage BI Publisher.
3. In the Runtime Configuration, click Properties.
4. The Memory Guard settings set thresholds for report size and runtimes.

Changing Memory Guard Settings

To change the Memory Guard settings, review the process described in MyOracle Support (Doc ID 2199494.1). Use the provided Customer Memory Guard Change Request Template to provide details of the changes you want and attach it to a service request for review by Oracle Support.

Using a Dedicated Business Intelligence Publisher Cluster for Critical Jobs: Procedure

For some time-sensitive reports, including for example paycheck and invoice generation, you can use a dedicated Business Intelligence Publisher cluster by setting the report’s priority as critical, ensuring that reports are run during critical time windows.

Critical jobs are assigned to a dedicated cluster. To set a report as critical:

1. Open the report.
2. Click Properties.
In the Advanced Report Properties in the General tab, select Critical in the Job Priority list.

Determining Which Reports Are Prioritized as Critical
To review which reports have been marked as critical, navigate to Report Job Histories, where critical jobs are highlighted.

Setting Up the Delivery Channel

Setting Up the Delivery Channel and Enabling Encryption: Procedure

BI Publisher supports Oracle WebCenter Content as the recommend delivery channel for delivering reports for distribution. You can use the provisioned connection to deliver files from BI Publisher to WebCenter Content, or configure a custom connection to deliver Pretty Good Privacy (PGP) encrypted files from BI Publisher.

Using the Default Connection
By default, a provisioned WebCenter Content connection, FA_UCM_Provisioned, uses a provisioned FUSION_APPS_OBIA_BIEE_APPID user to connect to WebCenter Content with security groups and accounts to support the most common use cases.

Creating a Custom Connection
If you have specific requirement to access WebCenter Content using user credentials other than FUSION_APPS_OBIA_BIEE_APPID, or if you want to use PGP key encryption, you can add a custom connection. When you create a custom connection for WebCenter Content, it must use the same Uniform Resource Identifier (URI) as the provisioned connection, but should have its own user name and password.

To create a custom connection:

1. In the BI Publisher Administration page, navigate to the Content Server tab in the Delivery section, and click Add Server.
2. Enter the same URI used by the provisioned FA_UCM_Provisioned WebCenter Content server.
3. Enter the server name, URI, user name, and password.
4. Leave Enable Custom Metadata deselected. Custom metadata is not used.
5. Click Test Connection to ensure that you can connect.
6. Click Apply.

Configuring File Encryption
You can use PGP encryption to secure the file delivery.
To use PGP encryption:

1. Upload the PGP public keys to import the PGP keys of WebCenter Content.
   a. Navigate to the Security Center section in the BI Publisher Administration page.
   b. Click PGP Keys to open the PGP Keys page.
   c. In the PGP Keys section, click Browse and select the PGP key file in the Open dialog box.
   d. Click Upload. The uploaded file is imported into the keystore and its details are visible in the PGP Keys table. If a key with the same ID is imported again, the file is overwritten.
e. Click **Download** for the key in the Encrypted Test Output column of the PGP Keys table to download and decrypt a test output file using the secret key of the imported public key. Successful decryption confirms the encryption is working for your keys.

2. Enable delivery of PGP encrypted files in a custom connection to WebCenter Content.
   
a. Navigate to the Delivery section and the Content Server page.
b. Select the custom content server connection you want to configure.
c. Select the imported key by its ID from the PGP Keys list and verify that the GPG command is populated in the Filter Command.
d. Click **Apply**.

### Delivering Content: Procedure

Use a scheduled job to deliver content and documents.

#### Scheduling a Job to Deliver Content

To schedule a job to deliver documents:

1. In BI Publisher, click **Create** and select **Report Job**.
2. In Schedule Report Job, on the General tab, click **search** for the Report field.
3. In the Open dialog box, navigate to and select the report, and then click **Open**.
4. In Schedule Report Job, in the Frequency list on the Schedule tab, select the option to use for this report.
5. In Schedule Report Job, on the Output tab, choose **Content Server** in the Destination Type list.
6. Click **Add Destination**.
7. Select the server from the Server list.
8. Select the WebCenter Content security group to assign to the report.
9. (Optional) Select an account within the Security Group to assign to the report.
10. (Optional) Select the Folder Path to deliver files to an existing folder in the content server.
11. (Optional) Enter a value for Author. If you don’t enter an author, your user name is used for the Author metadata in WebCenter Content.
12. (Optional) Type a Title for the report. If you don’t enter a title, the layout name is used for the title.
13. Enter the file name to assign to the delivered document on the remote server, for example, `myreport.pdf`.
14. Ensure that you don’t include files with the same name in one folder. The File Name field is used as the Native File Name in WebCenter Content. If you don’t supply a file name value, the Output name is used.
15. (Optional) Type a description to include with the document in WebCenter Content.
16. Deselect **Include Custom Metadata**.
17. Click **Submit**.
18. In the Submit dialog box, type a name in the Report Job Name field, and click **OK**.
19. Click **Home** and navigate to the Report Job History page to verify the report delivery status.
3 Subject Areas

Data Structure for Analytics: Explained

The business intelligence (BI) repository contains the metadata that defines which columns you can include in analyses, and the source of that data. The repository is organized into subject areas, which contain folders with the columns.

Note: You can also use the BI repository as a data source for reports.

Columns

This table describes the three types of columns available when you create or edit analyses.

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fact</td>
<td>Provides a measure of something, meaning that the values are numbers.</td>
<td>Total</td>
</tr>
<tr>
<td>Attribute</td>
<td>Represents a piece of information about a business object, with values that are dates, IDs, or text.</td>
<td>Start Date</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Holds data values that are organized in a hierarchical manner.</td>
<td>Time, with sublevels:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Year</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Quarter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Month</td>
</tr>
</tbody>
</table>

Note: Attribute columns can be flexfield segments imported into the BI repository.

Subject Areas

When you create an analysis, you first select a subject area, which contains columns related to a specific business object or area. Then, open folders within the subject area to find the columns to include.

Folders

Each subject area has one fact folder and a number of dimension folders. Folders can have subfolders.

- **Fact folders:**
  - Contain fact columns.
  - Are usually the last in a list of folders and are usually named after the subject area.
• **Dimension folders:**
  - Contain attribute and hierarchical columns.
  - Are joined to the fact folder within a subject area.

  For example, if your analysis has the Currency attribute from a dimension folder, you see currencies in the results. If you also add the Total fact, then your analysis includes only records with both a currency and a total amount. The more columns you add, the smaller the query set for your analysis.
  - Can be common folders, or common dimensions, that appear in more than one subject area.

  If your analysis has columns from multiple subject areas, then you:
  - Should include columns only from dimension folders that are common to all of those subject areas. At least one such column is required.
  - Must include one column from the fact folder in each of those subject areas.

**Related Topics**

- Creating and Editing Analytics: Highlights
- Creating and Editing Analyses with Advanced Features: Procedure
- Creating and Editing Analyses Using a Wizard: Procedure
- Modifying Data Models: Procedure

**Why do I get a list of all legal employers instead of only one when I create a report?**

If you select only one dimension in an analysis, the dimension is not secured by the data security of the user. The resulting report returns all dimension values. Add one or more dimensions or metrics to the analysis, to filter the report by the security profile of the user.
4  Flexfields

Configuring Flexfields for Use in Analyses: Overview

Flexfields are extensible sets of placeholder fields associated with business objects which can be placed on application pages. You can use flexfields to extend business objects and meet your data management requirements without changing the data model or performing any database programming. To include flexfields you have used for extension for use in analyses, you must enable them for business intelligence.

Extension of analyses using flexfields is available for Oracle Enterprise Resource Planning Cloud and Oracle Human Capital Management Cloud. For Oracle Sales Cloud, the Extensibility Framework supports extension.

Flexfield Types

The following types of flexfields are available and provide a means to modify application features without programming:

- Descriptive
- Extensible
- Key

Depending on the flexfield type, business intelligence enablement is performed differently and has different requirements. Once they are enabled for business intelligence, you can import any changes made to flexfields automatically using an import scheduled process.

Configuring Key Flexfields for Transactional Business Intelligence

Enabling Key Flexfields for Business Intelligence Reporting: Procedure

To include flexfields in your Transactional Business Intelligence reporting, you must enable them for Business Intelligence. Extensibility of analysis using flexfields is used for Enterprise Resource Planning and Human Capital Management. For Customer Relationship Management, the Extensibility Framework supports this.

To designate key flexfields as BI-enabled:

1. Navigate to Manage Key Flexfields in Oracle Applications Cloud.
2. Enter your search value in Key Flexfield Code.
3. Click Manage Structure Instances.
4. Enter your search value in Structure Instance Code.
5. Click Edit to display the Edit Key Flexfield Structure Instance dialog box.
6. Select the BI Enabled option, then click OK.
7. For each flexfield segment instance, repeat steps 5 through 6.
8. Click Save.
9. Populate the BI Object Name for each of the segment labels:
   a. Query the Key Flexfield Code in the Manage Key Flexfields window.
   b. From the Actions menu, select Manage Segment Labels.
   c. Populate the BI Object Name for each segment label to be mapped. The BI Object Name for the following qualified segment labels should not be modified:

<table>
<thead>
<tr>
<th>Segment Label Code</th>
<th>BI Object Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FA_COST_CTR</td>
<td>Dim - Cost Center</td>
</tr>
<tr>
<td>GL_BALANCING</td>
<td>Dim - Balancing Segment</td>
</tr>
<tr>
<td>GL_ACCOUNT</td>
<td>Dim - Natural Account Segment</td>
</tr>
</tbody>
</table>

Before you deploy a flexfield, you must access the Chart of Accounts Instance and assign the newly created segment label to the appropriate segment in the Chart of Accounts.

d. Click Deploy Flexfield.
e. Click Save and Close.

Related Topics
- Enabling Key Flexfield Segments for Business Intelligence: Points to Consider

Supported HCM Key Flexfields: Overview

Key flexfields are used to store internally defined codes unique to a particular business, specifying part numbers, general ledger accounts, and other business entities.

<table>
<thead>
<tr>
<th>Product Area</th>
<th>Key Flexfield</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll</td>
<td>Costing</td>
<td>Dim - Costing Segments</td>
</tr>
</tbody>
</table>

Mapping Non-Qualified Segments to BI Objects: Procedure

To map non-qualified segments that must be mapped and used in analysis, create a new label and associate a BI object with the label. Associate this new segment label with the segment code.

To map non-qualified segments to BI objects:

1. From Manage Key Flexfields, search for the appropriate key flexfield code.
2. From the Actions menu, select Manage Segment Labels.
3. Click the Add Row icon.
4. Enter the details for the Segment Label Code, including name, description, and BI Object name. Enter the BI object names carefully and note whether there is a space between Segment and the number.

This table provides examples of Key Flexfields and associated BI object names.
5. Complete the mapping by assigning unique segment labels to the key flexfields.

Setting Up the GL Accounting Flexfields: Procedure

This topic describes the workflow for setting up Accounting key flexfields, but these steps also apply for other key flexfields.

- Understanding Accounting Key Flexfields
- Identifying Accounting Key Flexfields
- Assigning Unique Segment Labels
- Performing Column Flattening
- Designating GL Accounting Segment Instances as BI-Enabled
- Deploying Accounting Key Flexfields

Understanding Accounting Key Flexfields

The Accounting Key Flexfield is used to identify GL accounts.

A chart of accounts segment is a component of the accounting key flexfield. Each segment has a value set attached to it to provide formatting and validation of the set of values used with that segment. The combination of segments creates the account combination used for recording and analyzing financial transactions. You must set up your Chart of Accounts (COA) as part of implementing Oracle Applications Cloud.

Examples of segments that may be found in a chart of accounts structure include Company, Cost Center, Department, Division, Region, Account, Product, Program, and Location.

The Natural Account segment of the General Ledger Accounting Key Flexfield defines the account used in the account combination to record transactions.

The logical segment dimensions in the Oracle BI metadata are `Dim - Cost Center`, `Dim - Balancing Segment`, `Dim - Natural Account Segment` and all `Dim - GL Segmentn` dimensions. These dimension tables are populated from a Tree value object or from a Value Set value object. Which value is used depends on whether a tree was associated with the segment in the Oracle Applications Cloud setup:

- For each segment associated with trees, two value objects are generated (Tree and TreeCode) with the following naming structure:
  
  \[ FscmTopModelAM.AccountBIAM.FLEX_TREE_VS\_segmentlabel\_VI & FscmTopModelAM.AccountBIAM.FLEX_TREECODE_VS\_segmentlabel\_VI \]

- For each segment without trees, one view object is generated with the following naming structure:
  
  \[ FscmTopModelAM.AccountBIAM.FLEX\_VS\_XXX\_VI \]
In addition to the segment dimension tables, the BI Extension process also extends **Flex BI Flattened VO**: `FscmTopModelAM.AccountBIAM.FLEX_BI_Account_VI`. This view object has a pair of columns for each segment; `segmentlabel_` and `segmentlabel_c`.

For example, for your Cost Center segment which has the segment label `FA_COST_CTR`, there are two columns in this view object, named `FA_COST_CTR_` and `FA_COST_CTR_c`.

### Identifying Accounting Key Flexfield Segments

Identify and map segments of the chart of accounts.

For each Chart of Accounts (Accounting Key Flexfield) used to analyze Transactional Business Intelligence facts, identify the segments of the chart of accounts. Map them to the Transactional Business Intelligence GL Accounting Segment logical dimensions.

<table>
<thead>
<tr>
<th>Accounting Key Flexfield Segment</th>
<th>Segment Label</th>
<th>Transactional Business Intelligence GL Accounting Segment Logical Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balancing</td>
<td>GL_BALANCING</td>
<td>Dim - Balancing Segment</td>
</tr>
<tr>
<td>Natural Account</td>
<td>GL_ACCOUNT</td>
<td>Dim - Natural Account Segment</td>
</tr>
<tr>
<td>Cost Center</td>
<td>FA_COST_CTR</td>
<td>Dim - Cost Center</td>
</tr>
<tr>
<td>Other segments to be equalized</td>
<td>Other unique segment</td>
<td>Dim - GL Segment n where n is an integer from 1 to 10</td>
</tr>
<tr>
<td></td>
<td>label</td>
<td></td>
</tr>
</tbody>
</table>

### Assigning Unique Segment Labels

You must assign a unique segment label to the charts of accounts segments that are the balancing segments or the natural account segments. The segments must be also used for specific purposes.

For example, assign the Primary Balancing segment label to the segment used for your company or legal entities. That label provides a correct recording of intercompany transactions and company analysis. You can assign other segment labels when required.

To assign unique segment labels to charts of accounts segments:

1. Launch the **Manage Charts of Accounts** task and then navigate to the Manage Chart of Accounts page.
2. In the Search section, enter the GL# for the **Key Flexfield Code** and click the **Search** button.
3. In the Search Results section, select **Accounting Flexfield** and click the **Manage Structures** button to navigate to Manage Key Flexfield Structures.
4. In the Search section, enter the chart of accounts code or the name for Structure Code or Name and click the **Search** button.
5. In the Search Results section, select the chart of accounts and click **Edit** to navigate to the Edit Key Flexfield Structure window.
6. Select the **Enabled** check box to code-enable the Structure code.
7. In the Segments section, select the applicable segments and click **Edit** to navigate to the Edit Key Flexfield Segment window.
8. Select the Enabled check box to enable the segments.
9. In the Segment Labels section, select the unique segment labels to equalize the segments across the charts of accounts. Click the **shuttle** to move the segments to the selected list.
10. Click **Save and Close** to return to the Edit Key Flexfield Structure window.
11. Click **Done** to return to the Manage Key Flexfields window.

### Performing Column Flattening

Column flattening of trees is required in order for OTBI hierarchy analyses to be populated with correct data.

To flatten columns for account hierarchies:

1. Launch **Manage Trees and Tree Versions** and navigate to the Manage Trees and Tree Versions window.
2. In the Search section, enter **GL_ACCT_FLEX** for the Tree Structure Code and the involved tree code or name, and click **Search**.
3. In the Search Results section, select the tree version you want to flatten. If the status of the Tree Version is Draft, to make the Tree Version active, select **Actions**, then **Status**, and then **Active**.
4. (Optional): After the tree version is specified, perform an audit on the Tree Version to ensure its integrity before launching the flattening job. Select **Actions** and then **Audit**. See the section on working with Trees in the Developer’s Guide.
5. Choose **Column Flattening** from the **Actions** menu.
6. Click the **Online Flattening** button to launch the flattening job immediately. Or, click the **Schedule Flattening** button to schedule the flattening job according to your requirements.

### Designating GL Accounting Segment Instances as BI-Enabled

Specify the applicable chart of accounts segment instances that are BI-enabled to make them available for use in Transactional Business Intelligence.

To specify the chart of accounts segment instances as BI-enabled:

1. In the Search Results section of the Manage Key Flexfields window, select **Accounting Flexfield** and click the **Manage Structure Instances** button to navigate to the Manage Key Flexfield Structure Instances window.
2. In the Search section, select the chart of accounts for Structure Name and click the **Search** button.
3. In the Search Results section, select the structure instance and click **Edit** to navigate to the Edit Key Flexfield Structure Instance window.
4. Check the **Enabled** check box to code-enable the structure instance.
5. In the Segment Instances section, select the segment instances and click **Edit** to update. Each of the segment instances must be selected individually.
6. Select the **Business Intelligence enabled** check box in the Edit Key Flexfield Segment pop-up window and click **OK** to return to Edit Key Flexfield Structure Instance window.
7. After you have enabled all applicable segment instances for Business Intelligence, click **Save and Close** to save the changes and return to the Edit Key Flexfield Structure Instance window.
8. Repeat steps 2 - 6 for each chart of accounts to enable all the applicable segment instances for Business Intelligence.
9. Click **Done** to return to the Manage Key Flexfields window.
10. After you have configured all the charts of accounts, click the **Deploy Flexfield** button to deploy the Accounting Flexfield and make the latest definition available for use.

### Deploying Accounting Key Flexfields

After you have set up accounting key flexfields, you must deploy them.

Accounting key flexfields have one of the following deployment statuses:

- **Edited**: The flexfield definition has not been deployed or changes have been made to the structure, the structure instances, or the value sets.
- **Patched**: The flexfield definition has been modified through an update, but the flexfield has not yet been deployed so the updated definition is not reflected.
Deployed to Sandbox: The flexfield is deployed and available in a flexfield-enabled sandbox.

Deployed: The flexfield definition is deployed and available to end users.

Error: The deployment attempt failed.

To deploy accounting key flexfields:

1. Access Manage Chart of Accounts from Setup and Maintenance work area.
2. Click Search.
3. Locate the Deployment Status column.
4. Click the icon.
5. Select Edited.
6. Click Deploy Flexfield.
7. Monitor the Deployment Status and when it reaches 100% click OK.
8. Verify that a check mark displays in the Deployment Status column.
9. Click Done.

Related Topics

- Specifying Performance Options for a Tree Structure: Points to Consider
- Deploying Flexfields Using the Command Line: Explained

Configuring Descriptive Flexfields for Transactional Business Intelligence

Configuring Descriptive Flexfields for Transactional Business Intelligence: Overview

Configure descriptive flexfields to track unique information not typically found on business forms.

Descriptive flexfields can store several important details on a form without cluttering it. For example, several details may make an asset form heavy and unmanageable. However, the user still needs to access those details and therefore, they must be present on the form. In such cases, descriptive flexfields are convenient to use and are easy to manage.

Descriptive flexfields provide a way for you to add attributes to entities and to define validation and display properties for them. A descriptive flexfield is a logical grouping of attributes (segments) that are mapped to a set of extension columns which are shipped as part of Oracle Applications Cloud tables.

Configuring Descriptive Flexfield Segments: Procedure

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business Intelligence.

Configuring a Descriptive Flexfield Segment

If a descriptive flexfield is enabled for Oracle Business Intelligence, you can enable global and context segments for Oracle Business Intelligence, and you can select segment labels. Not all descriptive flexfields are supported for Business Intelligence.
To configure available descriptive flexfield segments:

1. Navigate to the Setup and Maintenance window.
2. Navigate to the Manage Descriptive Flexfields window.
3. If the BI Enabled option is cleared, select it.
4. Select the options for deployment of the descriptive flexfields.

Setting Descriptive Flexfields as BI-Enabled: Procedure

If a descriptive flexfield is already defined, you can enable it for use in Business Intelligence reports. Not all descriptive flexfields are supported for Business Intelligence.

Setting a Flexfield as BI-Enabled

1. Navigate to Setup and Maintenance work area.
2. Navigate to the Edit Descriptive Flexfields window.
3. Enter the descriptive flexfield name.
4. Check the BI Enabled option on the desired descriptive flexfields. If the option is unavailable, the flexfield is a non-supported entity.
5. Click OK.
6. Click Save.

Configuring Extensible Flexfields for Transactional Business Intelligence

Configuring Extensible Flexfields: Procedure

You can use extensible flexfields to configure more segments.

An extensible flexfield is similar to a descriptive flexfield in that it provides an expansion space that you can use to configure additional attributes (segments) without additional programming. As with descriptive flexfields, each segment is represented in the database as a single column. However, with extensible flexfields, the context values and context-sensitive segments are stored in an extension table.

Categories and Contexts

You can combine and arrange the segments into attribute groups that are tailored to your specific needs. For example, you can group related segments so that they appear together on the page. The attribute groups are referred to as contexts. You can optionally set up an extensible flexfield to enable categorization of contexts.

You can add contexts and segments to extensible flexfields just like the descriptive flexfields. To see the extensible flexfields in analyses, you need to deploy them and then run the BI Extender Essbase scheduled process.

Configuring Extensible Flexfields

To configure extensible flexfields:

1. Open the Manage Extensible Flexfield task in the Setup and Maintenance work area.
2. Search for the EFF you want to configure, then select it and click the Edit icon.

3. In the Edit Extensible Flexfield dialog, highlight the category Display Name, then select Manage Contexts.

4. In the Manage Context dialog, search for the context that contains the segment you want to configure, highlight it, then click the Edit icon.

5. In the Edit Context dialog, click the Edit icon.

6. Edit the segment, as required, then click Save.

Related Topics

- Flexfield Usages: Explained

Setting Extensible Flexfields as BI-Enabled: Procedure

Extensible flexfields are BI enabled if at least one segment in a context is BI enabled.

Setting Extensible Flexfields as BI-Enabled

To set extensible flexfields as BI-enabled:

1. Navigate to Setup and Maintenance.
2. Navigate to Manage Extensible Flexfields.
3. Enter the extensible flexfield name; for example, Organization Information EFF.
4. Select the applicable extensible flexfield, and then click Edit.
5. Select the applicable Category. The category contexts are populated automatically.
6. Click Manage Contexts
7. In the Edit Context page, select the applicable Context, and then click Edit.
8. Select the applicable Segment, and then click Edit.
9. In the Edit Segment page, select the BI Enabled check box.
10. Click Save.

Essbase Rule File and Cubes: Overview

Generate the Essbase rule file by running the Create Rules XML File for BI Extender Automation scheduled process.

The Essbase rule file must be generated for all Oracle Essbase cubes mapped in the repository file (RPD).

Job Status Conditions

The process status displays one of these conditions.

- INIT: The process has just begun and is waiting for the extender command line JAR to update the status with more details.
- COMPLETED_NO_EXTENSION_NEEDED: No new Flexfield changes were detected in any of the Oracle Applications Cloud sources; because the RPD is already synchronized with all Flexfield changes, no changes were made in the RPD.
- COMPLETED: The RPD was successfully updated with Flexfield changes and uploaded into the Oracle Business Intelligence server.
- FAILED: Error conditions exist which require manual intervention.
Importing Changes to Flexfields Automatically

Importing Flexfield Changes: Overview

You can use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to import your flexfield changes.

Use the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process to automatically import the following types of changes:

- Key Flexfield changes
- Descriptive Flexfield changes
- Extensible Flexfield changes

The Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process imports extensible data, including data in descriptive flexfield segments, key flexfield segments, and General Ledger balances in Essbase cubes.

If you have changes to key flexfields and descriptive flexfields, you can import all the changes in the same scheduled process.

This is an Oracle Applications Cloud scheduled process; it is not related to BI Applications. Detailed information on this process can be found in Oracle Applications Cloud documentation.

⚠️ Note: We strongly recommend that you backup the Oracle Business Intelligence Enterprise Edition prior to importing any flexfield changes. Running the process disconnects all users from the server. You should not run this process when maintenance operations or system updates are being performed on the server.

Running the Import Scheduled Process: Procedure

To import changes, run the Import Oracle Fusion Data Extensions for Transactional Business Intelligence scheduled process.

Running the Job

To run the process:

1. In the Scheduled Processes window, select Search and Select: Name.
2. Select Search and Select: Name.
3. Highlight Import Oracle Fusion Data Extensions for Transactional Business Intelligence.
4. Click OK.
5. Schedule the process.

Process Status Conditions

When the process is finished, the biExtenderCMDUtility.jar writes the status of the process into the JNDI file ess_biExtenderEssJob_jobStatus, which can be viewed in Oracle WebLogic Server.
The process status displays one of the following conditions:

- **INIT**: The process has just begun and is waiting for the extender command line JAR to update the status with more details.
- **COMPLETED_NO_EXTENSION_NEEDED**: No new Flexfield changes were detected in any of the Oracle Applications Cloud sources; because the Oracle Business Intelligence is already synchronized with all Flexfield changes, no changes were made in the Oracle Business Intelligence.
- **COMPLETED**: Oracle Business Intelligence was successfully updated with Flexfield changes and uploaded into the Oracle Business Intelligence Server.
- **COMPLETED: PROCESS_ERRORS**: Oracle Business Intelligence was updated with the Flexfield changes but with some warnings that require manual intervention.
- **FAILED**: Error conditions exist that require manual intervention.

### Successful Import Process

If the import process is successful, you can perform the following actions:

- Query subject areas by segment dimensions such as Balancing Segment and Cost Center.
- Access DFF attributes for analyses.
- Use the General Ledger - Balances Real Time subject area to query Oracle Essbase cubes.

### Disabling Flexfields as BI-Enabled

#### Overview

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

There may be times, such as during development phases, when you try using a flexfield and later determine it is no longer needed.

**Note**: If you are considering disabling flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence. If you disable a flexfield, it cannot be deployed. Also, error conditions may occur if you disable a descriptive flexfield that has been implemented in BI Applications. If error conditions arise from disabling flexfields as BI-enabled, troubleshooting the errors can be difficult and time-consuming.

### Disabling Key Flexfields as BI-Enabled: Procedure

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling key flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence.
Disabling Key Flexfields

To disable key flexfields as BI-enabled:

1. Navigate to **Manage Key Flexfields**.
2. Enter your search value in **Key Flexfield Code**.
3. Click **Manage Structure Instances**.
4. Enter your search value in **Structure Instance Code**.
5. Click **Edit**. The Edit Key Flexfield Structure Instance dialog box displays.
6. In **Edit Key Flexfield Segment Instance**, deselect the **BI Enabled** option.
7. Click **OK**, then **Save**.

Disabling Descriptive Flexfields as BI-Enabled: Procedure

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling descriptive flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Transactional Business Intelligence.

Disabling Descriptive Flexfields

To disable descriptive flexfields as BI-enabled:

1. Navigate to **Setup and Maintenance**.
2. Navigate to the **Edit Descriptive Flexfields** window.
3. Enter the **Descriptive Flexfield Name**.
4. Deselect the **BI Enabled** option on the desired descriptive flexfields.
5. Click **OK**, then **Save**.

Disabling Extensible Flexfields as BI-Enabled: Procedure

If you created a flexfield that you no longer want to use or report against, you can disable the flexfield as BI-enabled.

If you are considering disabling extensible flexfields, keep in mind that any flexfields created in Oracle Applications Cloud must be designated as BI-enabled to be exposed in Oracle Transactional Business Intelligence.

Disabling Extensible Flexfields

To disable extensible flexfields as BI-enabled:

1. Navigate to **Setup and Maintenance**, then **Manage Extensible Flexfields**.
2. Enter the extensible flexfield Name; for example, "Organization Information EFF."
3. Select the applicable extensible flexfield and click **Edit** to navigate to Edit Extensible Flexfield.
4. Select the applicable Category. The category contexts are populated automatically.
5. Click **Manage Contexts** to navigate to Manage Contexts.
6. Select the applicable Context and click **Edit** to navigate to Edit Context.
7. Select the applicable Segment and click **Edit** to navigate to Edit Segment.
8. Deselect the **BI Enabled** option.
9. Click **Save**.
Dimensions Supported by Descriptive Flexfields

Human Capital Management Descriptive Flexfields for Oracle Transactional Business Intelligence

This topic lists the Human Capital Management descriptive and extensible flexfields that you can use with Oracle Transactional Business Intelligence and includes:

- Oracle HCM Cloud page where the flexfield appears.
- Folder in Transactional Business Intelligence that contains the flexfield after you import it.

This table lists the descriptive flexfields.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Code and Name</th>
<th>Location in Oracle HCM Cloud</th>
<th>Location in Transactional Business Intelligence</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANC_ABSENCE_CATEGORIES_DFF</td>
<td>Manage Absence Categories</td>
<td>Dimension: Assignment Absences Details</td>
</tr>
<tr>
<td>Absence Category Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANC_ABSENCE_PLANS_DFF</td>
<td>Manage Absence Plans</td>
<td>Dimension: Assignment Absences Details</td>
</tr>
<tr>
<td>Absence Plan Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANC_ABSENCE_REASONS_DFF</td>
<td>Manage Absence Reasons</td>
<td>Dimension: Assignment Absences Details</td>
</tr>
<tr>
<td>Absence Reason Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ANC_ABSENCE_TYPES_DFF</td>
<td>Manage Absence Types</td>
<td>Dimension: Assignment Absences Details</td>
</tr>
<tr>
<td>Absence Type Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ABSENCE_DFF</td>
<td>Record Absence</td>
<td>Dimension: Assignment Absences Details</td>
</tr>
<tr>
<td>Absence Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ACT_DFF</td>
<td>Manage Employment Actions</td>
<td>Dimension: HR Action</td>
</tr>
<tr>
<td>Additional Action Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ACT_LEG_DDF</td>
<td>Manage Actions</td>
<td>Dimension: HR Action</td>
</tr>
<tr>
<td>Legislative Action Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ACT_REASONS_DFF</td>
<td>Manage Employment Actions</td>
<td>Dimension: HR Action Reason</td>
</tr>
<tr>
<td>Additional Action Reason Attributes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Descriptive Flexfield Code and Name

<table>
<thead>
<tr>
<th>Flexfield Code and Name</th>
<th>Location in Oracle HCM Cloud</th>
<th>Location in Transactional Business Intelligence</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADDRESSES_DFF</td>
<td>Manage Person</td>
<td>Dimension: Location</td>
</tr>
<tr>
<td>PER_ALL_PEOPLE_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Details</td>
</tr>
<tr>
<td>PER_ASG_DF</td>
<td>Employment Assignment</td>
<td>Dimension: Worker Assignment Details</td>
</tr>
<tr>
<td></td>
<td>Assignment Attributes</td>
<td></td>
</tr>
<tr>
<td>PER_ASG_LEG_DDF</td>
<td>Employment Information page, Assignment tab for these tasks:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add Contingent Worker</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Manage Employment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add Assignment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add Employment Terms (Also appears on the Terms tab for this task)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Employment Information page, Assignments tab, Contracts region (Single Contract Single Assignment) for these tasks:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Hire an Employee</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add NonWorker</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Add Pending Worker</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Create Work Relationship</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Job Details page in Manager Self-Service (Line Manager) for these tasks:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Promote</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Transfer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Change Working Hours</td>
<td></td>
</tr>
<tr>
<td>PER_CITIZENSHIPS_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Citizenship</td>
</tr>
<tr>
<td></td>
<td>Citizenship Attributes</td>
<td></td>
</tr>
<tr>
<td>PER_CONTACT_RELSHIPS_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Contact Relationship</td>
</tr>
<tr>
<td></td>
<td>Contact Relationships Attributes</td>
<td></td>
</tr>
<tr>
<td>PER_CONTRACT_DF</td>
<td>Manage Employment - Employment Term</td>
<td>Dimension: Employment Contract Details</td>
</tr>
<tr>
<td></td>
<td>Contract Attributes</td>
<td></td>
</tr>
<tr>
<td>PER_CONTRACT_LEG_DDF</td>
<td>Employment Information page, Terms tab, Contracts region (Single Contract Single Assignment) for these tasks:</td>
<td>Dimension: Employment Contract Details</td>
</tr>
<tr>
<td></td>
<td>Contract Legislative Information</td>
<td></td>
</tr>
</tbody>
</table>

---

**Oracle Human Capital Management Cloud**

**Creating and Administering Analytics and Reports for HCM**

**Chapter 4**

**Flexfields**
<table>
<thead>
<tr>
<th>Descriptive Flexfield Code and Name</th>
<th>Location in Oracle HCM Cloud</th>
<th>Location in Transactional Business Intelligence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment) for these tasks for the Line Manager and HR Specialist:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Hire an Employee</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add NonWorker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add Pending Worker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Create Work Relationship</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Also appears on these pages:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Manage Employment (HR Specialist) - Terms tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add Assignment - Employment Information page, Assignment tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add Employment Terms -Employment Information page, Terms tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_DOC_OF_RECORD_LEG_DDF</td>
<td>Document of Record Legislative Information</td>
<td>Manage Documents of Record</td>
</tr>
<tr>
<td>Documents of Record Attributes</td>
<td></td>
<td>Dimension: Document of Record Details</td>
</tr>
<tr>
<td>PER_DOC_OF_RECORD_LEG_DFF</td>
<td>Manage Documents of Record</td>
<td>Dimension: Document of Record Details</td>
</tr>
<tr>
<td>PER_DRIVERS_LICENSE_TYPES_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Driver License</td>
</tr>
<tr>
<td>Drivers License Types Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_EMAIL_ADDRESSES_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Email Addresses</td>
</tr>
<tr>
<td>Email Addresses Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ETHNICITIES_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Ethnicity</td>
</tr>
<tr>
<td>Ethnicity Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_GRADES_DF</td>
<td>Manage Grades</td>
<td>Dimension: HR Grade</td>
</tr>
<tr>
<td>Grade Additional Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_JOBS_DFF</td>
<td>Manage Jobs</td>
<td>Dimension: Job</td>
</tr>
<tr>
<td>Job Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_JOB_FAMILY_DFF</td>
<td>Manage Job Family</td>
<td>Dimension: Job</td>
</tr>
<tr>
<td>Job Family Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_LOCATIONS_DF</td>
<td>Manage Location</td>
<td>Dimension: Worker Location</td>
</tr>
<tr>
<td>Location Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Descriptive Flexfield Code and Name</td>
<td>Location in Oracle HCM Cloud</td>
<td>Location in Transactional Business Intelligence</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIERS_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person National Identifiers</td>
</tr>
<tr>
<td>National Identifiers Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_ORGANIZATION_UNIT_DFF</td>
<td>Manage Department</td>
<td>Dimension: Department</td>
</tr>
<tr>
<td>Organization Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_ADDR_USG_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Address</td>
</tr>
<tr>
<td>Person Address Usage Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_CONTACT_RELATIONSHIP_DDF</td>
<td>Person Contact Relationship Information</td>
<td>Manage Person</td>
</tr>
<tr>
<td>PER_PERSON_DISABILITY_DFF</td>
<td>Manage Person</td>
<td>Person Disability</td>
</tr>
<tr>
<td>Person Disability Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_DISABILITY_LEG_DDF</td>
<td>Manage Person</td>
<td>Person Disability</td>
</tr>
<tr>
<td>Person Disability Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_DLVRY_METHODS_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Delivery Methods</td>
</tr>
<tr>
<td>Delivery Methods Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSONDRIVERS_LICENSE_LEG_DDF</td>
<td>Manage Person</td>
<td>Dimension: Person Driver License</td>
</tr>
<tr>
<td>Person Drivers License Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_LEGISLATIVE_DATA_LEG_DDF</td>
<td>Manage Person and New Hire</td>
<td>Dimension: Person Legislative Information</td>
</tr>
<tr>
<td>Person Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_LEGISLATIVE_DFF</td>
<td>Legislative section of Manage Person</td>
<td>Dimension: Person Legislative Information</td>
</tr>
<tr>
<td>Person Legislative Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_NAME_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Names</td>
</tr>
<tr>
<td>PER_PERSON_NAME_LEG_DDF</td>
<td>Not exposed</td>
<td>Dimension: Person Names</td>
</tr>
<tr>
<td>Person Name Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSON_PASSPORT_LEG_DDF</td>
<td>Manage Person and New Hire</td>
<td>Dimension: Person Passport Details</td>
</tr>
<tr>
<td>Person Passport Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Descriptive Flexfield Code and Name</td>
<td>Location in Oracle HCM Cloud</td>
<td>Location in Transactional Business Intelligence</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>PER_PERSON_TYPE_USG_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Types</td>
</tr>
<tr>
<td>PER_PERSON_VISA_LEG_DDF</td>
<td>Manage Person and New Hire</td>
<td>Dimension: Person Work Permit</td>
</tr>
<tr>
<td>Person Visa Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PERSONS_DFF</td>
<td>New Hire</td>
<td>Dimension: Worker</td>
</tr>
<tr>
<td>Persons Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PHONES_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Phones</td>
</tr>
<tr>
<td>Phones Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_POSITIONS_DFF</td>
<td>Manage Position</td>
<td>Dimension: HR Position</td>
</tr>
<tr>
<td>Position Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PPS_LEG_DDF</td>
<td>Employment Information page, Work Relationship Details region for Line Manager and HR Specialist for these tasks:</td>
<td>Dimension: Work Relationship Details</td>
</tr>
<tr>
<td>Work Relationship Legislative Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Hire an Employee</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add Contingent Worker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add NonWorker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Add Pending Worker</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Create Work Relationship</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Manage Work Relationship (HR Specialist) - Work Relationship Details</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work Relationship Details region in these tasks:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Manager Self-Service (Line Manager and HR Specialist), Terminate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Manage Work Relationship (HR Specialist)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_PPS_DF</td>
<td>Manage Work Relationship, Termination, Add Person, Create Work Relationship</td>
<td>Dimension: Work Relationship Details</td>
</tr>
<tr>
<td>Work Relationship Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_RELIGIONS_DFF</td>
<td>Manage Person</td>
<td>Dimension: Person Religion</td>
</tr>
<tr>
<td>Religions Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PER_VISA_PERMIT</td>
<td>Manage Person</td>
<td>Dimension: Person Work Permit</td>
</tr>
<tr>
<td>Visa Permit Attributes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
This table lists the extensible flexfields in HCM (Core HR and Payroll).

<table>
<thead>
<tr>
<th>Extensible Flexfield Name and Code</th>
<th>Location in Oracle HCM Cloud</th>
<th>Location in Transactional Business Intelligence</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER.Assignments.EIT.EFF</td>
<td>• Hire an Employee (Line Manager and HR Specialist) - Employment Information page, Assignment tab</td>
<td>Dimension: Worker Assignment Details</td>
</tr>
<tr>
<td></td>
<td>• Hire an Employee (Line Manager and HR Specialist) - Employment Information Page, Contracts Region (Single Contract Single Assignment)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manage Employment (HR Specialist) - Assignment tab</td>
<td></td>
</tr>
<tr>
<td>PER.Jobs.EIT.EFF</td>
<td>Manage Jobs</td>
<td>Dimension: Job</td>
</tr>
<tr>
<td>PER.Jobs.LEG.EFF</td>
<td>Manage Jobs</td>
<td>Dimension: Job</td>
</tr>
<tr>
<td>PER.Location.Information.EFF</td>
<td>Manage Locations</td>
<td>Dimension: Worker Location</td>
</tr>
<tr>
<td>PER.Location.LEG.EFF</td>
<td>Manage Locations</td>
<td>Dimension: Worker Location</td>
</tr>
<tr>
<td>PER.Organization.Information.EFF</td>
<td>Manage Departments</td>
<td>Dimension: Department</td>
</tr>
<tr>
<td>PER.Person.EIT.EFF</td>
<td>Manage Person</td>
<td>Fact - Person</td>
</tr>
<tr>
<td>PER.Positions.EIT.EFF</td>
<td>Manage Positions</td>
<td>Dimension: HR Position</td>
</tr>
<tr>
<td>PER.Positions.LEG.EFF</td>
<td>Manage Positions</td>
<td>Dimension: HR Position</td>
</tr>
</tbody>
</table>
Chapter 5  
Analytics Modification

Creating and Editing Analytics: Highlights

Edit and create analytics to provide ad hoc reporting on your transactional data. The predefined analyses and dashboards help answer many of your business questions, but you can also create your own to meet your requirements. This table gives a just a few examples of creating or editing analytics.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an analysis</td>
<td>Your team needs a simple list of all your accounts, sorted by account ID. You include the account name, ID, and address in a new analysis, and add sorting on the ID column.</td>
</tr>
<tr>
<td>Create a view</td>
<td>A predefined analysis has a bar graph. You save a new version of this analysis with a table view added to the graph.</td>
</tr>
<tr>
<td>Create a view selector</td>
<td>You later decide that you want to toggle between viewing a table and a graph. You add a view selector that includes the table and graph views.</td>
</tr>
<tr>
<td>Edit a dashboard prompt</td>
<td>A predefined dashboard has a Start Date prompt. You make a copy of the dashboard and replace Start Date with a date range prompt.</td>
</tr>
<tr>
<td>Create a dashboard</td>
<td>You create a dashboard that includes an analysis and a report to view both together.</td>
</tr>
</tbody>
</table>

**Tip:** A wizard in the Reports and Analytics work area and panel tab is available to help you create or edit analyses.

Data Source Modification

Administrators can modify the business intelligence (BI) repository to determine the columns available for you to use.

- They enable flexfields (which support attributes) for BI, and import them into the repository.
- You can then select attributes from flexfields to include in your analyses.

**Related Topics**

- Reports and Analytics Work Area and Panel Tab: Explained
- Data Structure for Analytics: Explained
- Configuring Flexfields for Use in Analyses: Overview
Analyses

Creating and Editing Analyses Using a Wizard: Procedure

You can use a wizard that guides you through creating and editing analyses. Even though the wizard doesn't give you all available features, you can still use it to make typical changes, for example adding views or filters. For other tasks, such as creating dashboards or deleting analyses, use the advanced business intelligence features.

Creating an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click Create and select Analysis.
3. Select the subject area that has the columns you want for your analysis.
4. Optionally, add more subject areas or remove any that you no longer need.
5. Select the columns to include, set options for each column, and click Next.
6. Optionally, enter a title to display for the analysis.
7. Select the type of table or graph to include, specify the layout of the views, and click Next.

Note: At any point after this step, you can click Finish to go to the last step, to save your analysis.

8. Optionally, set more options for the table or graph, and click Next.
9. Optionally, add sorts or filters based on any of the columns you included, and click Next.
10. If you have a table, optionally define conditional formatting for select columns, for example to display amounts over a certain threshold in red. Click Next.
11. Enter the name of your analysis and select a folder to save it in.
12. Click Submit.

Editing an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and edit it. In the Reports and Analytics work area, click More for the analysis and select Edit. In the Reports and Analytics panel tab, click the analysis, then click Edit.
3. Perform steps 4 through 10 from the preceding Creating an Analysis task, as needed.
4. To update an existing analysis, select the same name in the same folder. To save this analysis as a new copy, either name it with a new name or save it in a new folder.
5. Click Submit.

Related Topics

- Reports and Analytics Work Area and Panel Tab: Explained
- Saving Analytics and Reports: Points to Consider
- Data Structure for Analytics: Explained
Creating an Absences by Department Analysis: Worked Example

You are an HR specialist and you want to create an analysis to help you review what types of absences are occurring across all departments.

The following table summarizes key decisions for creating the analysis.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
</table>
| What information to include? | • Department name  
| | • Absence reason  
| | • Number of absences |
| What type of layout is required? | Table with a bar graph below it. |
| Do the table columns require any special formatting? | Yes, for the purpose of easier scanning. For the table, associate colors with thresholds so that 30 or more absences of one type are highlighted in red. And, associate colors with thresholds so that 10 or fewer absences of one type are highlighted green. |
| Is this analysis available for others to use? | No. Save it to My Folders. |

To create an analysis of absences by department, complete these tasks:

1. Select columns
2. Define the layout
3. Add column formatting
4. Save the analysis

Selecting Columns

1. Navigate to the Reports and Analytics work area.
2. Click Create.
3. Select Analysis.
4. In the Select Subject Area window, select the Workforce Management - Absence Real Time subject area.
5. On the Create Analysis: Select Columns page, expand the Workforce Management - Absence Real Time folder.
6. Expand the Department folder.
7. Select Name and click the Add icon button to move the column to the Selected Columns area.
8. Expand the Absence Reason folder.
9. Select Absence Reason Name and click the Add icon button to move the column to the Selected Columns area.
10. Expand the Assignment Absences folder.
11. Select # Of Absences and click the Add button to move the column to the Selected Columns area.
12. Click Next.

Defining the Layout

1. On the Create Analysis: Select Views page, enter Absence by Department in the Name field.
2. Next to the Table field, click None to open the Table menu.
3. Select Table (recommended).
4. Next to the Graph field, click None to open the Graph menu.
5. Select Bar (recommended).
6. Use the default layout value of Table above Graph.
7. Click Next.
8. On the Create Analysis: Edit Graph page, click Next.

Adding Column Formatting
1. On the Create Analysis: Highlight page, click Add Column Format in the Formatting region.
2. Select # Of Absences.
3. In the first Threshold field, enter 10, and click the down arrow in the first Color field. Select the color Green.
   Tip: If you hover over the colors, hover text shows the name of the color.
4. In the second Threshold field, enter 30, and click the down arrow in the third Color field. Select the color Red (leave the second color yellow).
5. Click Next.

Saving the Analysis
1. In the Create Analysis: Save page, Save In region, enter Absence by Department in the Analysis Name field, enter a description, and then select My Folders.
2. Click Submit.
3. Click OK.

Creating and Editing Analyses with Advanced Features: Procedure
Even though you can use a wizard to create or edit analyses, you might have to use advanced features for complicated analyses or specific requirements. For example, you can create view selectors so that users can toggle between views within an analysis, or define criteria for filters using SQL statements.

You can also perform other actions on analyses, for example delete them or copy and paste them within the business intelligence catalog.

Creating or Editing an Analysis
1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click the Browse Catalog button.
3. Click the New button, select Analysis under Analysis and Interactive Reporting, and select a subject area.
   Or, select your analysis in the Folders pane and click Edit.
4. Use the tabs as described in this table.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Criteria</td>
<td>Select and define the columns to include.</td>
</tr>
<tr>
<td></td>
<td>Add filters.</td>
</tr>
<tr>
<td>Results</td>
<td>Add views and set options for results.</td>
</tr>
<tr>
<td>Prompts</td>
<td>Define prompts to filter all views in the analysis.</td>
</tr>
<tr>
<td>Advanced</td>
<td>View or update the XML code and logical SQL statement that the analysis generates.</td>
</tr>
<tr>
<td></td>
<td>Set options related to query performance.</td>
</tr>
</tbody>
</table>
5. Save your analysis.

Performing Other Actions on an Analysis

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the analysis.
2. Select your analysis and click **Action** and select **More**.
3. Click **More** for your analysis and select the wanted action, for example **Delete** or **Copy**.

**Related Topics**

- Reports and Analytics Work Area and Panel Tab: Explained
- Data Structure for Analytics: Explained
- Saving Analytics and Reports: Points to Consider

How can I provide access to a custom analysis or report to multiple users?

By default, shared analyses and reports are owned by the duty role of the user who created them. All users with that duty role are able to view, modify, and save the objects.

Cross-Subject Area Joins

Cross-Subject Area Joins: Overview

You can create analyses that combine data from more than one subject area. This type of query is referred to as a cross-subject area analysis. Cross-subject area analyses can be classified into three broad categories:

- Using common dimensions.
- Using common and local dimensions.
- Combining more than one result set from different subject areas using set operators such as union, union all, intersection and difference.

**Common Dimensions**

A common dimension is a dimension that exists in all subject areas that are being joined in the report. These dimensions are considered common dimensions between subject areas and can be used to build a cross-subject area report.

**Common and Local Dimensions**

A local dimension is available only in one of the combined subject areas in a cross-subject area query.
Creating a Cross-Subject Area Analysis: Procedure

To create a real-time analysis that includes more than one subject area, which is referred to as a cross-subject area analysis, the analysis must include a measure from each of the subject areas to support the join if it uses a local dimension. You can hide the measure in the results if you don’t want it to appear in your analysis.

Creating a Cross-Subject Area Analysis

1. In the Reports and Analytics work area, click Browse Catalog.
2. Click New and select Analysis.
3. In the Select Subject Area window, select a subject area.
4. In the Criteria tab, expand the dimensions and add a column to the analysis.
5. In the Subject Areas region, click Add/Remove Subject Areas.
6. In the Subject Area region of the Criteria tab, expand the dimensions and add a column to the analysis.
7. If the column is a local dimension, add a measure from the subject area. If it’s preferable to hide the measure in your analysis, select its Column Properties, and in the Column Format tab of the Column Properties dialog box, select the Hide check box and click OK.
8. If you are using a local dimension, in the Advanced tab, navigate to the Advanced SQL Clauses section, select Show Total value for all measures on unrelated dimensions, then click Apply SQL.
9. Click the Results tab to see the results of the analysis.
10. Click the Criteria tab again to return to the analysis definition.

Reporting for HCM as of a Specific Date: Explained

The ability to report as of a specific date depends on whether you are reporting on event-type measures or non-event type measures.

Event-Type Measures

Event-type measures in Transactional Business Intelligence are those that include a time dimension, or specific date associated with them. Examples include assignment events, absences, and performance. Because these measures have specific dates associated with them, you can run queries against them as of a specific date. You can produce trend reports for any subject area that has the time dimension, meaning any subject area that contains event-type measures.

Non-Event Type Measures

Non-event type measures don’t have a specific date associated with them. Examples include headcount and salary. Transactional Business Intelligence is designed to report on non-event measures as of the current date. To report on non-event measures as of a specific date, add a prompt for the date to your analysis. And, add this SQL statement to the analysis: `SET VARIABLE PARAM_EFFECTIVE_DATE='@{AsOfDate}';`

Related Topics

- Creating a Date-Effective Headcount Analysis: Worked Example
Cross-Subject Area Analyses

Cross-Subject Area Analyses: Explained

You can create analyses that combine data from more than one subject area. This type of query is referred to as a cross-subject area analysis. Cross-subject area analyses can be classified into three broad categories:

- Using common dimensions
- Using common and local dimensions
- Combining more than one result set from different subject areas using set operators such as union, union all, intersection and difference.

Common Dimensions

A common dimension is a dimension that exists in all subject areas that are being joined in the report. For example, Workforce Management - Worker Assignment Real Time and the Workforce Management - Worker Assignment Event Real Time subject areas have Worker, Job, and Department available. These dimensions are considered common dimensions between these two subject areas and they can be used to build a cross-subject area report.

Common and Local Dimensions

The Worker Assignment Details dimension in the Workforce Management - Worker Assignment Real Time subject area is not available in the Workforce Management - Worker Assignment Event Real Time subject area. Therefore it’s a local dimension for the purposes of a cross-subject area query between these two subject areas.

Creating a Cross-Subject Area Analysis for HCM: Worked Example

This example demonstrates how to create a real-time analysis that includes more than one subject area, which is referred to as a cross-subject area analysis. In this example, you create an analysis of headcount by department with the annualized salary in the local currency.

The following table summarized key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which subject areas are needed?</td>
<td>For headcount by department, select Workforce Management - Worker Assignment Real Time. For salary, select Compensation - Salary Details Real Time.</td>
</tr>
<tr>
<td>Does the analysis require an SQL statement?</td>
<td>Yes, to join the two subject areas.</td>
</tr>
</tbody>
</table>

Creating a Cross-Subject Area Analysis

1. In the Reports and Analytics work area, click Browse Catalog.
2. Click New and select Analysis.
3. In the Select Subject Area window, select the **Workforce Management - Worker Assignment Real Time** subject area.

4. In the Subject Area region of the Criteria tab, expand the Department folder.

5. Click **Name** and drag it to the Selected Columns area.

6. Expand the Worker Assignment folder.

7. Click **Headcount** and drag it to the Selected Columns area to the right of the Department Name column.

8. In the upper-right corner of the Subject Areas region, click **Add/Remove Subject Areas**.

9. In the Add/Remove Subject Areas window, select **Compensation - Salary Details Real Time**.

10. Click **OK**.

11. In the Subject Areas region of the Criteria tab, expand the Compensation - Salary Details Real Time folder.

12. Expand the Salary folder.

13. Click **Annualized Salary** and drag it to the Selected Columns area to the right of the headcount column.

14. Click the **Results** tab to see the results of the analysis.

15. Click the **Criteria** tab again to return to the analysis definition.

16. In the Subject Areas region on the Criteria tab, expand the Salary Details folder in the Compensation - Salary Details Real Time folder.

17. Click **Apps Local Currency Code** and drag it to the Selected Columns area to the right of the Annualized Salary column.

18. Click the **Results** tab to view the report again. The headcount column is now blank.

19. To correct the blank headcount, click the **Advanced** tab.

20. On the Advanced tab, scroll down to the Advanced SQL Clauses region.

21. Select the **Dimension** check box.

   When you select this check box, the logical SQL is appended with the following request variable value, enabling you to join the two subject areas: `SET VARIABLE ENABLE_DIMENSIONALITY = 1;`

22. Click **Apply SQL**.

23. In the Message from Web page window, click **OK**.

24. Click the **Results** tab again to see that the headcount column now has numbers.

25. Click **Save Analysis**.

26. Save to My Folders, and enter Headcount by Department in the **Name** field, and enter a description for your analysis.

---

### Dashboards

#### Creating and Editing Dashboards: Procedure

You can create and edit dashboards to determine their content and layout. In addition to objects in the business intelligence (BI) catalog, such as analyses, reports, and prompts, you can add text, sections, and more to a dashboard.

#### Creating a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.

2. Click **Browse Catalog**.

3. Click **New** and select **Dashboard** under **Analysis and Interactive Reporting**.

4. Enter the dashboard's name and description, and select a folder to save in.

5. With the **Add content now** option selected, click **OK**.

6. Optionally, add more pages, or tabs, within the dashboard.

7. Drag and drop items from the Dashboard Objects or Catalog pane to add content to a page.

8. Click **Save**.
Note: The first dashboard page is saved with the page 1 name by default. To rename this page:

1. Click the Catalog link.
2. In the Folders pane, select your dashboard.
3. For page 1, click More and select Rename.
4. Enter the new name and click OK.

Editing a Dashboard

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas where you can find the dashboard.
2. Select your dashboard in the pane and click More.
3. Click Edit.
4. Perform steps 5 and 6 from the preceding Creating Dashboards task, and make other changes as needed, for example:
   - Remove content from the dashboard.
   - Drag and drop within a page to move content around.
   - Change the layout of a page.

Related Topics

- Saving Analytics and Reports: Points to Consider
- Reports and Analytics Work Area and Panel Tab: Explained

Configurable Email Notifications

HCM Configurable Workflow Notifications: Overview

As part of workflow tasks, the application automatically sends notifications to your users. For example, when a user submits a performance goal for approval, the approvers receive a notification with the approval request. For some flows, Oracle Business Intelligence (BI) Publisher reports determine the notification content and format, and you can edit the report to configure the email and in-app notifications. These report-based notifications are not only configurable, but also optimized for viewing on mobile devices. In addition to getting notifications in email, users can also view in-app notifications, for example by

- Clicking the Notifications icon in the global header and opening a notification
- Going to the Worklist: Notifications and Approvals work area and opening a notification
- Clicking the Online Notification link at the end of an email notification

Such business flows include the following HCM workflow tasks:

- Absence recording approvals
- Discretionary disbursement approvals
- Donation approvals
- Profile management
- Profile approvals
- Goal management
- Goal approvals
- Career development
- Feedback
- Performance management
- Performance document approvals
- Talent review
- Add assignment
- Add contact
- Add contingent worker
- Add nonworker
- Add pending worker
- Add terms
- Approve time cards
- Change assignment
- Change manager
- Change work schedule
- Change working hours
- Create contracts
- Document records
- Manage areas of responsibility
- Manage checklists
- Manage directs
- Manage employment
- Manage grades
- Manage grade ladders
- Manage grade rates
- Manage jobs
- Manage locations
- Manage organizations
- Manage positions
- Manage work relationship
- New hire
- Person external identifiers
- Person notes
- Personal information
- Promotion
- Share information
- Termination
- Transfer
Process Overview
The process to generate email and in-app notifications is the same as generating other types of report output. The process involves various types of objects in the business intelligence catalog, including data models, subtemplates, style templates, and reports.

This figure shows how these BI objects work together to generate the notification content.

- **Data Sources:** Store the attributes and attribute values for business objects and transactions in the application (example of data sources being transaction tables)
- **Data Model:** Determines which attributes from data sources are available to be included in the notification and how that data is retrieved
- **Subtemplate:** Provides common components, for example a branding logo and buttons, that can be reused in multiple reports
- **Style Template:** Provides styles such as the type of lines and fonts to use in tables, or the font type, size, and color to use for headings
- **Report:** Contains a layout template that determines:
  - Which attributes appear in the notification, from the data model used for the report
  - What the notification looks like, leveraging components from the subtemplate and styles from the style template used for the report
- **HTML:** Is the output generated from the report
- **Email Notification:** Has the HTML output embedded in the email body
- **In-App Notification:** Has the HTML output embedded in the application UI

Each workflow task with configurable notifications has a corresponding predefined report in the BI catalog. For example, the goal management approval notifications report contains the PerformanceGoalApprovalNotificationsReport layout template and uses the PerformanceGoalApprovalNotificationsDM data model. The generated output is included in emails that are sent to users for goal approval.
Notification Modifications

After you enable configurable email and in-app notifications, the predefined reports and related objects in the BI catalog work by default. The report-based notifications provide the same information as the standard notifications, but in a format optimized for mobile devices. If you must modify the notifications, you can edit copies of the predefined reports and data models, but not the style template. You proceed as you would to edit any report or data model in the catalog, for example:

1. Find a predefined report for goal approvals in the business intelligence catalog.
2. Use the Customize option to create a copy of the report that’s linked to the original.
3. Edit the copied report layout template.

For more information about configuring reports, see Oracle Human Capital Management Cloud Creating and Administering Analytics and Reports. You should get familiar with reports and BI Publisher in general before configuring workflow email and in-app notifications. Aspects specific to email and in-app notifications include:

- You use only the Template Builder for Word add-in to configure the .rtf template in Microsoft Word. You don’t use the layout editor or other tools available for configuring report layout.
- You usually edit a copy of predefined layout templates, rather than create reports or layout templates.

Security

To configure reports and data models for email and in-app notifications, you must have one of these duty roles or privilege:

- BI Platform Administrator duty role
- Publisher Data Model Developer duty role
- Manage BI Publisher Template privilege

Setup

You configure profile options to specify the HCM applications that use the BI Publisher reports rather than the default FYI and approval notifications. To use BI Publisher reports rather than the default workflow and approval notifications, you must:

- Configure profile options for email and in-app notifications to specify the HCM applications that use the BI Publisher reports.
- Download and install the Template Builder for Word add-in.

Configure profile options using the Manage Administrator Profile Values task in the Setup and Maintenance work area.

This table shows the profile option codes that determine which business processes use BI Publisher templates for email notifications. It also describes the effect of each code.

<table>
<thead>
<tr>
<th>Business Processes</th>
<th>Profile Option Code</th>
<th>Profile Display Name</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Absence Management</td>
<td>BIP_EMAIL_NOTIFICATION_HCM_ANC</td>
<td>BIP_EMAIL_NOTIFICATION_HCM_ANC</td>
<td>The application first checks this setting. If set to true, all Absence Management business processes that can use BI Publisher reports for workflow notifications use them.</td>
</tr>
<tr>
<td>All Global Human Resources</td>
<td>BIP_EMAIL_NOTIFICATION_HCM_PER</td>
<td>BI Publisher Notifications Enabled for Global Human Resources</td>
<td>The application first checks this setting. If set to true, all Global Human Resources business processes that can use BI</td>
</tr>
</tbody>
</table>
This table shows the profile option codes that determine which business processes use BI Publisher templates for in-app notifications. It also describes the effect of each code.

<table>
<thead>
<tr>
<th>Business Processes</th>
<th>Profile Option Code</th>
<th>Profile Display Name</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Talent Management</td>
<td>BIP_EMAIL_NOTIFICATION_HCM_TALENT</td>
<td>BI Publisher Notifications Enabled for Talent Management</td>
<td>Publisher reports for workflow notifications use them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The application first checks this setting. If set to true, all Talent Management business processes that can use BI Publisher reports for workflow notifications use them.</td>
</tr>
<tr>
<td>All HCM</td>
<td>BIP_EMAIL_NOTIFICATION_HCM</td>
<td>BIP EMAIL NOTIFICATION PER FAMILY LEVEL</td>
<td>Publisher reports for workflow notifications use them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The application checks this setting next. If set to true, all HCM business processes that can use BI Publisher reports for workflow notifications use them.</td>
</tr>
</tbody>
</table>

Related Topics

- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Workflow Tasks: Overview
• Oracle Business Intelligence: Highlights

Templates and Data Models Used for HCM Notifications Based on Reports

You can configure Oracle Business Intelligence (BI) Publisher reports to send notifications (email and in-app) for some HCM workflow tasks. Each business process uses different BI Publisher templates and data models for the email and in-app notifications.

Templates and Associated Data Models

This table shows the BI Publisher templates and the associated data models that are available for each business process.

<table>
<thead>
<tr>
<th>Business Process</th>
<th>Template (Data Model)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Career Development</td>
<td>CareerDevelopmentApprovalFYIReport (CareerDevelopmentApprovalNotificationDM)</td>
</tr>
<tr>
<td></td>
<td>CareerDevelopmentApprovalReport (CareerDevelopmentApprovalNotificationDM)</td>
</tr>
<tr>
<td></td>
<td>CareerDevelopmentFYINotification (CareerDevelopmentFyiDM)</td>
</tr>
<tr>
<td>Feedback</td>
<td>NoteSentToManagerReport (PersonNotes)</td>
</tr>
<tr>
<td></td>
<td>NoteSentToWorkerReport (PersonNotes)</td>
</tr>
<tr>
<td>Goal Management</td>
<td>PerformanceGoalApprovalNotificationsReport (PerformanceGoalApprovalNotificationsDM)</td>
</tr>
<tr>
<td></td>
<td>PerformanceGoalNotificationsReport (PerformanceGoalNotificationsDM)</td>
</tr>
<tr>
<td>Performance Management</td>
<td>PerformanceApprovalNotificationsReport (PerformanceApprovalDM)</td>
</tr>
<tr>
<td></td>
<td>PerformanceFyiNotificationsReport (PerformanceFYIDM)</td>
</tr>
<tr>
<td>Profile Management</td>
<td>ProfileChangeNotificationReport (ProfileChangeNotification)</td>
</tr>
<tr>
<td></td>
<td>ProfilesApprovalNotificationFYIReport (ProfilesApprovalNotificationDM)</td>
</tr>
<tr>
<td></td>
<td>ProfilesApprovalNotificationReport (ProfilesApprovalNotificationDM)</td>
</tr>
<tr>
<td>Talent Review</td>
<td>TalentCalibFYIReport (TalentCalibFYIDM)</td>
</tr>
<tr>
<td>Time and Labor</td>
<td>ApprovalEmailNotification (ApprovalEmailNotification)</td>
</tr>
<tr>
<td>Workforce Deployment</td>
<td>AddAssignmentReport (EmploymentCreateProcesses)</td>
</tr>
<tr>
<td></td>
<td>AddContactReport (AddContact)</td>
</tr>
<tr>
<td></td>
<td>AddCWKReport (EmploymentCreateProcesses)</td>
</tr>
<tr>
<td></td>
<td>AddNWKReport (EmploymentCreateProcesses)</td>
</tr>
<tr>
<td></td>
<td>AddPWKReport (EmploymentCreateProcesses)</td>
</tr>
<tr>
<td>Business Process</td>
<td>Template (Data Model)</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>AddTermsReport (EmploymentCreateProcesses)</td>
<td></td>
</tr>
<tr>
<td>AddWorkRelationshipReport (EmploymentCreateProcesses)</td>
<td></td>
</tr>
<tr>
<td>AssignmentChangeReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>CancelWorkRelationshipReport (EmploymentWRProcesses)</td>
<td></td>
</tr>
<tr>
<td>ChangeLegalEmployerReport (EmploymentCreateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ChangeLocationReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ChangeManagerReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ChangeSalaryReport (ChangeSalary)</td>
<td></td>
</tr>
<tr>
<td>ChangeWorkHoursReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>CreateGradeLadderReport (ManageGradeLadders)</td>
<td></td>
</tr>
<tr>
<td>CreateGradeRateReport (ManageGradeRates)</td>
<td></td>
</tr>
<tr>
<td>CreateGradeReport (ManageGrades)</td>
<td></td>
</tr>
<tr>
<td>CreateJobReport (ManageJobs)</td>
<td></td>
</tr>
<tr>
<td>CreateLocationReport (ManageLocations)</td>
<td></td>
</tr>
<tr>
<td>CreateOrganizationReport (ManageOrganizations)</td>
<td></td>
</tr>
<tr>
<td>CreatePositionReport (ManagePositions)</td>
<td></td>
</tr>
<tr>
<td>DeleteGradeLadderReport (ManageGradeLadders)</td>
<td></td>
</tr>
<tr>
<td>DeleteGradeRateReport (ManageGradeRates)</td>
<td></td>
</tr>
<tr>
<td>DeleteGradeReport (ManageGrades)</td>
<td></td>
</tr>
<tr>
<td>DeletePositionReport (ManagePositions)</td>
<td></td>
</tr>
<tr>
<td>EligibleJobsReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ExternalIdentifierReport (ExternalIdentifier)</td>
<td></td>
</tr>
<tr>
<td>ManageDirectsReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ManageDorReport (ManageDOR)</td>
<td></td>
</tr>
<tr>
<td>ManageEmploymentReport (EmploymentUpdateProcesses)</td>
<td></td>
</tr>
<tr>
<td>ManageWorkRelationshipReport (EmploymentWRProcesses)</td>
<td></td>
</tr>
<tr>
<td>NewHireReport (EmploymentCreateProcesses)</td>
<td></td>
</tr>
<tr>
<td>NoteSentToManagerReport (PersonNotes)</td>
<td></td>
</tr>
<tr>
<td>NoteSentToWorkerReport (PersonNotes)</td>
<td></td>
</tr>
<tr>
<td>NotifyCopyConflictReport (EmploymentWRProcesses)</td>
<td></td>
</tr>
<tr>
<td>NotifyDeleteConflictReport (EmploymentWRProcesses)</td>
<td></td>
</tr>
<tr>
<td>NotifyMultipleConflictReport (EmploymentWRProcesses)</td>
<td></td>
</tr>
</tbody>
</table>
### Layouts for Workflow Notifications: Points to Consider

Predefined workflow notifications based on report layout templates all follow a general format. When you edit a copy of these layout templates in Microsoft Word, follow the predefined layout as closely as possible for consistency. Also keep in mind shared components and mobile considerations.
General Structure

In general, the workflow notifications contain a set of components that are displayed in a certain order. The callouts in this figure identify the email notification components listed in the following table.

The callouts in this figure identify the in-app notification components listed in the following table. In addition to describing each component, the table also indicates if the component appears in the email notification, in-app notification, or both.
<table>
<thead>
<tr>
<th>Callout</th>
<th>Component</th>
<th>Notification Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Buttons with the primary actions to take on the task, such as Approve and Reject. These buttons aren’t part of the configurable, report-based notification content.</td>
<td>In-app</td>
</tr>
<tr>
<td>2</td>
<td>Notification header listing key attributes of the workflow task and the associated transaction.</td>
<td>Both</td>
</tr>
<tr>
<td>3</td>
<td>Buttons for the primary actions to take on the task, such as Approve and Reject.</td>
<td>Email</td>
</tr>
<tr>
<td>4</td>
<td>Notification body that usually includes transaction and line level details, displayed in tables or sets of attributes with corresponding values. The data model for the report restricts the total number of rows displayed in some of the tables. If the limit is exceeded, the table footer provides a link to the transaction details page, where users can view all the rows. To change this limit, you can edit a copy of the data model.</td>
<td>Both</td>
</tr>
<tr>
<td>5</td>
<td>Approval history, including any attachments that users in the history uploaded for the task. You can’t edit the approval history</td>
<td>Email (or both, in rare cases)</td>
</tr>
</tbody>
</table>
When you modify notifications, try to keep to this general structure and don’t remove essential elements such as the action buttons. Likewise, don’t change the styles in your layout template. The predefined style template should still apply to your notification; don’t edit a copy of the style template and apply that to your notification.

To add components to your notification, for example another table, consider first downloading another style template from My Oracle Support. This template contains Quick Parts content that you can use in Word when you do more advanced work on layout templates. For example, from the Quick Parts gallery, you can select and add the table that is consistent in format with predefined tables already on your notification.

By default, the components that you add in the layout template appear in both email and in-app notifications, where available. You can add conditions to explicitly make a particular element, for example a field, appear only in one type of notification and not the other.

### Shared Components

A predefined subtemplate in the business intelligence (BI) catalog applies to all predefined layout templates for workflow notifications. The subtemplate contains components that are shared among the notifications, for example:

- Branding logo, if you add one to the subtemplate, which would appear as the first component in the email body. The logo appears in email notifications only.
- Action buttons in email notifications.
- Links at the end of the email notification, one to the corresponding transaction page, and another to the in-app notification.

When you make a copy of a predefined layout template to edit, the copy automatically inherits the same predefined subtemplate. To edit these shared components, make a copy of the predefined subtemplate, edit the copied version, and apply it to your own layout templates.

### Mobile Considerations

Because users can view the workflow notifications on mobile devices, always consider mobile first and keep the notifications as simple as possible. For example:

- Don’t put too much content horizontally, such as too many columns in tables.
- Keep all text, including attributes and column headings, as short as possible.
- Center align lists of attributes and their values, if they appear outside tables.

Make sure to test your email notifications on mobile devices.

### Related Topics

- Subtemplates: Explained
• Defining the Number of Rows in Tables: Procedure

• Designating Content to Appear Only in Either Email or In-App Workflow Notifications: Procedure

Adding a Branding Logo and Modifying Other Shared Components in Workflow Notifications: Procedure

A predefined subtemplate contains common components for all workflow notifications based on predefined report layouts. For example, the subtemplate has a place for you to add a branding logo, which would appear at the beginning of email notifications. You can modify other shared components so that the same changes apply to your notifications. For example, for email notifications, you can also change the text on action buttons, or the text of the links that appear at the end of emails.

Note:
• You must edit a copy of the subtemplate in the Custom folder of the business intelligence (BI) catalog. Don’t directly update the predefined subtemplate.
• The exact steps can vary depending on your version of Microsoft Word.

Modifying Shared Components in the Subtemplate

To edit a copy of the predefined subtemplate that contains the shared components:

1. Click Navigator > Reports and Analytics.
2. Click the Browse Catalog icon.
3. In the BI catalog (the Folders pane), expand Shared Folders > Common Content > Templates.
4. For Workflow Notification Subtemplate, click More and select Customize.

If you’re not using the Customize option:
   a. Click Copy in the toolbar with Workflow Notification Subtemplate selected.
   b. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates. Create a Templates folder in this location if it doesn’t exist.
   c. Click Paste in the toolbar.
   d. Click the Edit link for the copied subtemplate.

All reports using the predefined subtemplate are automatically redirected to point to your subtemplate in the Custom folder. This applies:
   o To all reports, predefined or not
   o No matter if you copy and paste the subtemplate or use the Customize option
   o Only if your subtemplate has the same name and relative file path within Custom as the predefined subtemplate

5. In the Templates section, click the link in the Locale column.
6. Save the subtemplate .rtf file to your computer.
7. Open the .rtf file with Microsoft Word.
   o To add a logo, insert your own image in the subtemplate.
   o To change button or link text, edit the text accordingly. Make the same edits wherever that button or link text appears in the subtemplate.
Caution: To ensure that your layout templates reflect these changes without additional rework, don't edit any other text in the subtemplate .rtf file.

8. Update Word options to ensure that existing links remain intact in the subtemplate.
   a. Click File > Options > Advanced.
   b. In the Word Options dialog box, click Web Options in the General section.
   c. In the Web Options dialog box, open the Files tab.
   d. Deselect the Update links on save check box.

9. Save your changes in Word.

Uploading the Modified Subtemplate
To upload your subtemplate to the BI catalog:

1. In the BI catalog, expand Shared Folders > Custom > Common Content > Templates.
2. Click Edit for Workflow Notification Subtemplate.
3. In the Templates section, click the Upload icon.
4. Select your modified .rtf subtemplate and a locale, and click OK to overwrite the original subtemplate.

Related Topics

- Subtemplates: Explained
- Using the Customize Option for Predefined Reports: Points to Consider
- Generating Sample Report Data: Procedure

Using Quick Parts for Workflow Notifications: Explained

Use the Quick Parts feature in Microsoft Word to easily insert reusable pieces of formatted content. When you edit copies of predefined report layout templates for workflow notifications in Word, you can add predefined Quick Parts content to your .rtf file. For example, you can insert a table in a format that’s consistent with predefined notifications. The predefined Quick Parts content is available in a style template .dotx file on My Oracle Support.

Note: The exact steps can vary depending on your version of Microsoft Word.

Prerequisites
To get the predefined Quick Parts content into your Quick Parts gallery:

2. Download the .dotx file and save it to your Microsoft Word template folder, for example C:\Users\<user name>\AppData\Roaming\Microsoft\Templates.

Also, to preview your layout template changes before uploading the .rtf file back to the business intelligence (BI) catalog:

- Generate sample report data from the data model for the report that you’re editing.
- Download a local copy of the subtemplate that applies to the layout template.
Adding Quick Parts Content to Workflow Notifications

To insert content from the Quick Parts gallery into a layout template:

1. In the BI catalog, find the predefined report with the layout template that you want to modify.
2. For the report, click More and select Customize.
   
   If you’re not using the Customize option:
   a. Copy the predefined report and paste it in an appropriate subfolder within the Custom folder.
   b. Click the Edit link for the copied report.
3. Click Edit for the layout template to insert Quick Parts content into, and save the .rtf file to your computer with a new file name.
4. Open the .rtf file with Microsoft Word.
5. Put your cursor where you want to insert new content.
6. From the Insert tab on the ribbon, click Quick Parts within the Text group, and select the component to insert.
7. Edit the inserted component as needed and add any other components.
8. Save your changes in Word.

Previewing the Layout Template Changes

To preview your edits before uploading your layout template to the BI catalog:

1. On the ribbon, open the BI Publisher tab and click Sample XML within the Load Data group to import sample data from the data model. Skip this step if you already loaded sample data.
2. At the beginning of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change <import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?> to <import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>.
3. From the BI Publisher tab on the ribbon, click HTML in the Preview group.
4. If the preview reflects your changes as expected, then change the path back to the original location.
5. Save your changes in Word.

Uploading the Modified Layout Template

To upload your layout template to the BI catalog after previewing the changes:

1. Back in the BI catalog, click Edit for the report within the Custom folder, if that page isn’t still open.
2. Click the View a list link.
3. Click the Create icon on the table toolbar.
4. In the Upload or Generate Layout section, click Upload.
5. Upload your edited .rtf file with a unique layout name.
6. Back on the page for editing the report, click Delete for the layout template that you downloaded earlier.
7. Click the Save Report icon.

Related Topics

• Configurable Email Notifications: Implementation Considerations
• Using the Customize Option for Predefined Reports: Points to Consider
• Generating Sample Report Data: Procedure
• Style Templates: Explained
Configuring Feedback Notifications Using Reports: Worked Example

This example shows how to configure workflow email and in-app notifications for feedback using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>NoteSentToManager, for updates to notifications about feedback sent to managers</td>
</tr>
<tr>
<td>Do I add prompts and headers to the template?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do I add data model attributes to the template?</td>
<td>Yes, for DISPLAY_NAME and WORKER_DISPLAY_NAME</td>
</tr>
<tr>
<td>Which language do I use for the .rtf template?</td>
<td>English (United States)</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Configure a goal management notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.

If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm.
3. To preview the configured templates, download a local copy of the subtemplate that applies to your own report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
   - Click Edit for Workflow Notification Subtemplate.
In the Templates section, click the link in the Locale column.

Save the subtemplate .rtf file to your computer.

Exporting the Data Model XML File
In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management > Workflow Notifications and select Data Models to display the data models in the right pane.
4. Under Person Notes, click Edit to open the Diagram tab on the PersonNotes page.

Note: To ensure that all data sets include requested elements with null values in the output XML data, do the following:
   - In the Data Model section, select Properties.
   - In the Properties section, select Include Empty Tags for Null Elements.
   - In the Data Model section, select Data Sets.

Note: To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.
6. In the empty text field, enter the Note_ID for an existing feedback note to pull in all the feedback attributes.
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export.
9. In the Opening PersonNotes dialog box, select Save File and click OK.
10. Save the PersonNotes_.xml file to a local drive.

Downloading the Report Layout Template
In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management and select Workflow Notifications to display the templates in the right pane.
4. Under NoteSentToManagerReport, click More, and then select Customize. A copy of the NoteSentToManagerReport is created automatically in the Custom folder.
5. On the NoteSentToManagerReport page, under NoteSentToManagerReport, click Edit.
6. On the Opening NoteSentToManagerReport.rtf dialog box, select Save File and click OK to save the document to your local hard drive. Save the template with the name UpdatedNoteSentToManagerReport.rtf to distinguish it from the original template.

Editing the Template
To modify workflow email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.
Feature: The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedNoteSentToManagerReport.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Place the cursor at the end of the text AUTHOR_DISPLAY_NAME added feedback about WORKER_DISPLAY_NAME.
3. Enter recently. The text now reads AUTHOR_DISPLAY_NAME added feedback about WORKER_DISPLAY_NAME recently.
4. Place the cursor in front of the feedback code that includes <html2fo: NOTE_TEXT> and press the Enter key to add a line.
5. Enter Check out this feedback: When you preview the document, the feedback note appears below the text that you entered.
6. Save the document.
7. Proceed to the task Previewing the Document.

Previewing the Document
Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

1. In the Ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
2. Browse to and select the PerformanceGoalNotificationsDM_.xml file you downloaded to import sample data from the data model.
3. In the Data Loaded Successfully dialog box, click OK.
4. From the BI Publisher tab in the Ribbon, click HTML in the Preview group.
5. From the BI Publisher tab in the Ribbon, click Validate Template in the Tools group.
6. Also in the Tools group, click Check Accessibility.
7. Save your changes in Word.

Adding Data Model Attributes to the Template
In this task, you add to the report template attributes that exist in the predefined data model. You will add the DISPLAY_NAME and WORKER_DISPLAY_NAME data model attributes to the template.

1. Open the UpdatedNoteSentToManagerReport.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Select the BI Publisher tab.
3. In the Load Data section, click Sample XML.
4. In the dialog box to select XML data that appears, browse to open the PersonNotes_.xml file you saved in the Exporting the Data Model XML File task and click Open.
5. In the Data loaded successfully dialog box, click OK.
6. Place the cursor after the code containing <html2fo: NOTE_TEXT> and press the Enter key twice to add two new lines.
7. On the new line, enter Author Name:
8. On the BI Publisher tab, in the Insert section, click the 123 Field button to open the Field dialog box.
9. In the AUTHORNAME folder, select DISPLAY_NAME and click Insert. The field appears in the document.
10. Place the cursor after the data code DISPLAY_NAME and press the Enter key.
11. On the new line, enter Worker Name:
12. On the Field dialog box, in the WORKERNAME folder, select WORKER_DISPLAY_NAME and click Insert. The field appears in the document.

Note: Ensure that you don’t alter or remove the code WORKER_DISPLAY_NAME or Online Notification that appear at the bottom of the template.
13. Click Close to return to the UpdatedNoteSentToManagerReport.rtf template.
14. Preview the template using the steps in the Previewing the Document task.
15. Save and close the document.
16. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

Uploading the Modified Report Layout to the Oracle BI Publisher Catalog

You must perform this task to use the modified report layout for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog
4. Under NoteSentToManagerReport, click Edit.
5. On the NoteSentToManagerReport Data Model page, on the right side of the page, click Add New Layout to open the page with the Create Layout and Upload or Generate Layout sections.
6. In the Upload or Generate Layout section, click the Upload icon.
7. In the Upload Template File dialog box, in the Layout Name field, enter Updated Feedback Notifications Template.
8. In the Template File field, browse for the modified UpdatedNoteSentToManagerReport.rtf template on your local drive, select the template, and click Open.
9. In the Upload Template File dialog box, from the Type list, select RTF Template.
10. From the Locale list, select English (United States).
11. Click Upload to open the Processing dialog box and return to the NoteSentToManagerReport Data Model page.
12. On the right side of the page, click View a list to open the Layout page.
13. In the row for the Updated Feedback Notifications Template, select the Default Layout check box.
14. On the right side of the page, click the Save Report icon.

Configuring Workforce Deployment Notifications Using Reports: Worked Example

This example shows how to configure the promotion workflow email and in-app notification for the workforce deployment business process using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>PromotionReport, for updates to notifications about a worker’s promotion</td>
</tr>
<tr>
<td>Do I add prompts and headers to the template?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do I add data model attributes to the template?</td>
<td>Yes, for Person Type and Annual Salary</td>
</tr>
<tr>
<td>Which language do I use for the .rtf template?</td>
<td>English (United States)</td>
</tr>
</tbody>
</table>
Summary of the Tasks

Configure a promotion notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.

If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm.
3. To preview the configured templates, download a local copy of the subtemplate that applies to your own report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
   - Click Edit for Workflow Notification Subtemplate.
   - In the Templates section, click the link in the Locale column.
   - Save the subtemplate .rtf file to your computer.

Exporting the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management > Workflow Notifications and select Data Models to display the data models in the right pane.
4. Under Promotion data model, click Edit to open the Diagram tab on the Promotion data model page.

**Note:** To ensure that all data sets include requested elements with null values in the output XML data, do the following:

- In the Data Model section, select Properties.
- In the Properties section, select Include Empty Tags for Null Elements.
- In the Data Model section, select Data Sets.
Note: To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.
6. Enter the following attributes for the promotion that are key attributes and enable you to pull in all the goal attributes:
   - TransactionID
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export.
9. In the Opening Promotion_.xml dialog box, select Save File and click OK.
10. Save the Promotion_.xml file to a local drive.

Downloading the Report Layout Template

In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management and select Workflow Notifications to display the templates in the right pane.
4. Under PromotionReport, click More, and then select Customize. A copy of the PromotionReport is created automatically in the Custom folder.
6. On the Opening PromotionReportR11.rtf dialog box, select Save File and click OK to save the document to your local hard drive. Save the template with the name UpdatedPPromotionReport.rtf to distinguish it from the original template.

Editing Prompts and Headers in the Template

To modify email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.

Note: The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedPromotionReportR11.rtf template in Microsoft Word with the Template Builder installed, if not already open. The document contains all notifications for the workforce deployment business process.
2. Scroll to the notification with the header Promotion Details.
3. Place the cursor in front of the Description header text.
4. Enter Your. The text now reads Your Promotion Details.
5. Scroll to the prompt Mail Stop. Replace Mail Stop with Post Office Box.
6. Save the document.
7. Proceed to the task Previewing the Document.

Previewing the Document

Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails and in-app notification sent to users.

1. In the Ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
2. Browse to and select the PromotionReportDM_.xml file you downloaded to import sample data from the data model.
3. In the **Data Loaded Successfully** dialog box, click **OK**.

4. At the top of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<? import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:C:///Template_Directory/Workflow Notification Subtemplate.rtf?>`.

5. From the BI Publisher tab in the Ribbon, click **HTML** in the Preview group.

6. If the preview reflects your changes as expected, then change the path back to the original location.

7. From the BI Publisher tab in the Ribbon, click **Validate Template** in the Tools group.

8. Also in the Tools group, click **Check Accessibility**.

9. Save your changes in Word.

### Adding Data Model Attributes to the Template

In this task, you add to the report template attributes to data model. You will add the Person Type and Annual Salary data model attributes to the template.

1. Open the **UpdatedPerformanceGoalNotifications.rtf** template in Microsoft Word with the Template Builder installed, if not already open.

2. Select the BI Publisher tab.

3. In the Load Data section, click **Sample XML**.

4. In the dialog box to select XML data that appears, browse to open the **Promotion_.xml** file you saved in the Exporting the Data Model XML File task and click **Open**.

5. In the **Data loaded successfully** dialog box, click **OK**.

6. Scroll to the **Employee Details** notification.

7. Place the cursor after **Name** and press the Enter key.

8. On the new line, enter **Person Type**.

9. Place the cursor after the data code **ParentEntityName** and press the Enter key to enter a new line.

10. On the BI Publisher tab, in the Insert section, click the **123 Field** button to open the **Field** dialog box.

11. In the EMPLOYEEDETAILS folder, select **PERSON_TYPE** and click **Insert**. The field appears in the document.

12. Place the cursor after the data code **Department** and press the Enter key.

13. On the new line, enter **Annual Salary**.

14. Place the cursor after the data code **Department** and press the Enter key to enter a new line.

15. On the **Field** dialog box, in the EMPLOYEEDETAILS folder, select **ANNUAL_SALARY** and click **Insert**. The field appears in the document.

16. Click **Close** to return to the **PromotionReportR11.rtf** template.

17. Preview the template using the steps in the Previewing the Document task.

18. Save and close the document.

19. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

### Uploading the Modified Report Layout to the Oracle BI Publisher Catalog

You must perform this task to use the modified report layout for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.

2. Click **Catalog**.

3. On the Catalog page, in the Folders section, expand **Shared Folders > Custom > Human Capital Management** and select Workflow Notifications.

4. Under the **PromotionReport**, click **Edit**.

5. On the PromotionReport Data Model page, on the right side of the page, click **Add New Layout** to open the page with the Create Layout and Upload or Generate Layout sections.

6. In the Upload or Generate Layout section, click the **Upload** icon.
7. In the **Upload Template File** dialog box, in the **Layout Name** field, enter **Updated Promotion Template**.
8. In the **Template File** field, browse for the modified **Updated PromotionReportR11.rtf template** on your local drive, select the template, and click **Open**.
9. In the **Upload Template File** dialog box, from the **Type** list, select **RTF Template**.
10. From the **Locale** list, select **English (United States)**.
11. Click **Upload** to open the **Processing** dialog box and return to the PromotionReport page.
12. On the right side of the page, click **View a list** to open the Layout page.
13. In the row for the **Updated Promotion Report Template**, select the **Default Layout** check box.
14. On the right side of the page, click the **Save Report** icon.

**Related Topics**

- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Using the Customize Option for Predefined Reports: Points to Consider

### Configuring Talent Review Notifications Using Reports: Worked Example

This example shows how to configure workflow email and in-app notifications for the talent review business process using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>TalentCalibFYIReport, for updates to notifications about talent review meetings</td>
</tr>
<tr>
<td>Do I add prompts and headers to the template?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do I add data model attributes to the template?</td>
<td>Yes, for meeting date and meeting ID</td>
</tr>
<tr>
<td>Which language do I use for the .rtf template?</td>
<td>English (United States)</td>
</tr>
</tbody>
</table>

**Summary of the Tasks**

Configure a talent review notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.
If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites


2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm.

3. To preview the configured templates, download a local copy of the subtemplate that applies to your custom own report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
   - Click Edit for Workflow Notification Subtemplate.
   - In the Templates section, click the link in the Locale column.
   - Save the subtemplate .rtf file to your computer.

Exporting the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.

2. Click Catalog.

3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management > Workflow Notifications and select Data Models to display the data models in the right pane.

4. Under TalentCalibFYIDM, click Edit to open the Diagram tab on the Talent Calib FYI Data Model page.

   Note: To ensure that all data sets include requested elements with null values in the output XML data, do the following:
   - In the Data Model section, select Properties.
   - In the Properties section, select Include Empty Tags for Null Elements.
   - In the Data Model section, select Data Sets.

   Note: To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.

6. Enter the following attributes for an existing meeting that are key attributes and enable you to pull in all the meeting attributes:
   - MeetingId
   - ParticipantId
   - FYINotificationName
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export.
9. In the Opening TalentCalibFYIDM dialog box, select Save File and click OK.
10. Save the TalentCalibFYIDM_.xml file to a local drive.

Downloading the Report Layout Template

In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management and select Workflow Notifications to display the templates in the right pane.
4. Under TalentCalibFYIReport, click More, and then select Customize. A copy of the TalentCalibFYIReport is created automatically in the Custom folder.
6. On the TalentCalibFYIReport dialog box, select Save File and click OK to save the document to your local hard drive. Save the template with the name UpdatedTalentCalibReport.rtf to distinguish it from the original template.

Editing Prompts and Headers in the Template

To modify workflow email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.

> Note: The exact steps can vary depending on your version of Microsoft Word.

2. Scroll to the first notification with the header Talent Review Meeting Scheduled.
3. Place the cursor after the You are invited to the talent review meeting MEETING_TITLE. Meeting details are listed in this notification. body text.
4. Enter Ensure that you update content for your reports before the meeting.
5. Place the cursor right in front of Meeting Date. Enter Talent Review. The text now reads Talent Review Meeting Date.
6. Save the document.
7. Proceed to the task Previewing the Document.

Previewing the Document

Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

1. In the Ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
2. Browse to and select the TalentCalibFYIDM_.xml file you downloaded to import sample data from the data model.
3. In the Data Loaded Successfully dialog box, click OK.
4. From the BI Publisher tab in the Ribbon, click HTML in the Preview group.
5. From the BI Publisher tab in the Ribbon, click Validate Template in the Tools group.
6. Also in the Tools group, click Check Accessibility.
7. Save your changes in Word.
Adding Data Model Attributes to the Template

In this task, you add to the report template attributes that exist in the predefined data model. You will add the Meeting Date and Meeting ID data model attributes to the template.

1. Open the UpdatedTalentCalibReport.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Select the BI Publisher tab.
3. In the Load Data section, click Sample XML.
4. In the dialog box to select XML data that appears, browse to open the TalentCalibFYIDM_.xml file you saved in the Exporting the Data Model XML File task and click Open.
5. In the Data loaded successfully dialog box, click OK.
6. Scroll to the first notification with the header Talent Review Meeting Scheduled.
7. Place the cursor after Meeting Date and press the Enter key.
8. On the new line, enter Meeting ID.
9. Place the cursor after the data code MEETING_DATE and press the Enter key to create a new line.
10. On the BI Publisher tab, in the Insert section, click the 123 Field button to open the Field dialog box.
11. In the G_1 folder, select MEETING_ID and click Insert. The field appears in the document.
12. Click Close to return to the UpdatedTalentCalibReport.rtf template.
13. Preview the template using the steps in the Previewing the Document task.
14. Save and close the document.
15. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

Uploading the Modified Report Layout to the Oracle BI Publisher Catalog

You must perform this task to use the modified report layout for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog to open the Catalog page.
3. In the Folders section, expand Shared Folders > Custom > Human Capital Management and select Workflow Notifications.
5. On the TalentCalibFYIDM page, click Add New Layout to open the page with the Create Layout and Upload or Generate Layout sections.
6. In the Upload or Generate Layout section, click the Upload icon.
7. In the Upload Template File dialog box, in the Layout Name field, enter Updated Talent Review Notifications Template.
8. In the Template File field, browse for the modified UpdatedTalentCalibReport.rtf template on your local drive, select the template, and click Open.
9. In the Upload Template File dialog box, from the Type list, select RTF Template.
10. From the Locale list, select English (United States).
11. Click Upload to open the Processing dialog box and return to the TalentCalibFYIDM Data Model page.
12. On the right side of the page, click View a list to open the Layout page.
13. In the row for the Updated Talent Review Notifications Template, select the Default Layout check box.
14. On the right side of the page, click the Save Report icon.

Related Topics

- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Using the Customize Option for Predefined Reports: Points to Consider

---

Oracle Human Capital Management Cloud
Creating and Administering Analytics and Reports for HCM
Chapter 5
Analytics Modification

73
Configuring Performance Management Notifications Using Reports: Worked Example

This example shows how to configure workflow email and in-app notifications for the performance management business process using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>PerformanceFyiNotificationsReport</td>
</tr>
<tr>
<td>Do I add prompts and headers to the template?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do I add predefined data model attributes to the template?</td>
<td>Yes, for Evaluation ID</td>
</tr>
<tr>
<td>Which language do I use for the .rtf template?</td>
<td>English</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Configure a performance management notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.

If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm.
3. To preview the configured templates, download a local copy of the subtemplate that applies to your report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
Click Edit for Workflow Notification Subtemplate.
- In the Templates section, click the link in the Locale column.
- Save the subtemplate .rtf file to your computer.

Exporting the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management > Workflow Notifications and select Data Models to display the data models in the right pane.

![Note:](Image)

To ensure that all data sets include requested elements with null values in the output XML data, do the following:
- In the Data Model section, select Properties.
- In the Properties section, select Include Empty Tags for Null Elements.
- In the Data Model section, select Data Sets.

![Note:](Image)

To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.
6. Enter the Evaluation ID of an actual performance evaluation in the EvaluationID field to pull in all the performance document attributes. The Evaluation ID is a key attribute that enables you to see all available data attributes. Leave any existing sample data in these fields for any other fields.
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export.
9. In the Opening PerformanceFYIDM dialog box, select Save File and click OK.
10. Save the PerformanceFYIDM.xml file to a local drive.

Downloading the Report Layout Template

In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand Shared Folders > Human Capital Management and select Workflow Notifications to display the templates in the right pane.
4. Under PerformanceFyiNotificationsReport, click More, and then select Customize. A copy of the PerformanceFyiNotificationsReport is created automatically in the Custom folder.
6. On the Opening PerformanceFyiNotificationsReport .rtf dialog box, select Save File and click OK to save the document to your local hard drive. Save the template with the name UpdatedPerformanceFyiNotificationsReport.rtf to distinguish it from the original template.
Editing Prompts and Headers in the Template

To modify workflow email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.

**Note:** The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedPerformanceFYINotifications.rtf template in Microsoft Word with the Template Builder installed, if not already open. The document contains all notifications for the performance management business process.
2. Scroll to the Performance Document Reopened notification.
3. Select the Performance Document Reopened header text.
5. Scroll to the body text MGR_NAME reopened your performance document CUSTOMARY_NAME and place your cursor after the period.
6. Enter You can continue your evaluation.
7. Scroll to the Review Period text.
8. Place the cursor right before Review Period. Enter Performance Document. The text now reads Performance Document Review Period. (For TR, using Meeting Date - Enter Talent Review. The text now reads Talent Review Meeting Date.)
9. Save the document.

Previewing the Document

Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

1. In the Ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
2. Browse to and select the PerformanceFYIDM_.xml file you downloaded to import sample data from the data model.
3. In the Data Loaded Successfully dialog box, click OK.
4. From the BI Publisher tab in the Ribbon, click HTML in the Preview group.
5. From the BI Publisher tab in the Ribbon, click Validate Template in the Tools group.
6. Also in the Tools group, click Check Accessibility.
7. Save your changes in Word.

Adding Data Model Attributes to the Template

In this task, you add to the report template attributes that exist in the predefined data model.

1. Open the UpdatedPerformanceFYINotifications.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Select the BI Publisher tab.
3. In the Load Data section, click Sample XML.
4. In the dialog box to select XML data that appears, browse to open the PerformanceFYIDM_.xml file you saved in the Exporting the Data Model XML File task and click Open.
5. In the Data loaded successfully dialog box, click OK.
7. Place the cursor after Review Period and press the Enter key.
8. On the new line, enter Person ID.
9. Place the cursor after the data code REVIEW_PERIOD_NAME and press the Enter key to create a new line.
10. On the BI Publisher menu bar, in the Insert section, click the 123 Field button to open the Field dialog box.
11. In the PERSON_DETAILS folder, select PERSON_ID and click Insert. The field appears in the document.
12. Place the cursor after the **Person ID** text you entered in step 8 and press the Enter key.
13. On the new line, enter **Current Date**.
14. Place the cursor after the data code **PERSON_ID** you added in step 11 and press the Enter key to add a new line.
15. In the DATA_DS folder, select **PCURRENTDATE** and click **Insert**. The field appears in the document.
16. Click **Close** to return to the PerformanceFYINotifications.rtf template.
17. Preview the template using the steps in the Previewing the Document task.
18. Save and close the document.
19. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

### Uploading the Modified Report to the Oracle BI Publisher Server

You must perform this task to use the customized template for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click **Catalog**
3. On the Catalog page, in the Folders section, expand **Shared Folders > Custom > Human Capital Management** and select Workflow Notifications.
4. Under the **PerformanceFYIDM**, click **Edit**.
5. On the PerformanceFYINotificationsReport page, on the right side of the page, click **Add New Layout** to open the page with the Create Layout and Upload or Generate Layout sections.
6. In the Upload or Generate Layout section, click the **Upload** icon.
7. In the **Upload Template File** dialog box, in the **Layout Name** field, enter **Updated Performance FYI Notifications Report Template**.
8. In the **Template File** field, browse for the modified **UpdatedPerformanceFYINotificationsReport.rtf** template on your local drive, select the template, and click **Open**.
9. In the **Upload Template File** dialog box, from the **Type** list, select **RTF Template**.
10. From the **Locale** list, select **English (United States)**.
11. Click **Upload** to open the **Processing** dialog box and return to the Performance FYI Notifications Data Model page.
12. On the right side of the page, click **View a list** to open the Layout page.
13. In the row for the **Updated Performance FYI Notifications Template**, select the **Default Layout** check box.
14. On the right side of the page, click the **Save Report** icon.

**Related Topics**

- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Using the Customize Option for Predefined Reports: Points to Consider

### Configuring Goal Management Notifications Using Reports: Worked Example

This example shows how to configure workflow email and in-app notifications for the goal management business process using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>PerformanceGoalNotificationsReport, for updates to notifications about goal content</td>
</tr>
</tbody>
</table>
Decisions to Consider | This Example
--- | ---
Do I add prompts and headers to the template? | Yes
Do I add data model attributes to the template? | Yes, for Goal ID and Goal Plan ID
Which language do I use for the .rtf template? | English (United States)

Summary of the Tasks

Configure a goal management notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.

If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: [http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm](http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm).
3. To preview the configured templates, download a local copy of the subtemplate that applies to your own report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
   - Click Edit for Workflow Notification Subtemplate.
   - In the Templates section, click the link in the Locale column.
   - Save the subtemplate .rtf file to your computer.

Exporting the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog.
3. On the Catalog page, in the Folders section, expand **Shared Folders > Human Capital Management > Workflow Notifications** and select Data Models to display the data models in the right pane.

4. Under Performance Goal Notifications Data Model, click **Edit** to open the Diagram tab on the Performance Goal Notifications Data Model page.

**Note:** To ensure that all data sets include requested elements with null values in the output XML data, do the following:
- In the Data Model section, select Properties.
- In the Properties section, select Include Empty Tags for Null Elements.
- In the Data Model section, select Data Sets.

**Note:** To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.

6. Enter the following attributes for an existing goal that are key attributes and enable you to pull in all the goal attributes:
   - **GoalID**
   - **NotificationType**

7. Click **View** to see the sample data in the report, and all the available attributes.

8. Click **Export**.

9. In the **Opening PerformanceGoalNotificationsDM** dialog box, select **Save File** and click **OK**.

10. Save the **PerformanceGoalNotificationsDM_.xml** file to a local drive.

**Downloading the Report Layout Template**

In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.

2. Click **Catalog**.

3. On the Catalog page, in the Folders section, expand **Shared Folders > Human Capital Management** and select **Workflow Notifications** to display the templates in the right pane.

4. Under **PerformanceGoalNotificationsReport**, click **More**, and then select **Customize**. A copy of the PerformanceGoalNotificationsReport is created automatically in the Custom folder.


6. On the **Opening PerformanceGoalNotifications.rtf** dialog box, select **Save File** and click **OK** to save the document to your local hard drive. Save the template with the name UpdatedPerformanceGoalNotifications.rtf to distinguish it from the original template.

**Editing Prompts and Headers in the Template**

To modify workflow email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.

**Note:** The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedPerformanceGoalNotifications.rtf template in Microsoft Word with the Template Builder installed, if not already open. The document contains all notifications for the goal management business process.

2. Scroll to the notification with the header **Realign the Goal ALIGNED_GOAL_NAME Because the Goal GOAL_NAME was Canceled.**
3. Place the cursor in front of the **Description** header text.
4. Enter **Goal**. The text now reads **Goal Description**.
5. In the header **Realign the Goal ALIGNED_GOAL_NAME Because the Goal GOAL_NAME was Canceled**, place your cursor after **Realign**, enter **Your**, and delete the. The text now reads **Realign Your Goal ALIGNED_GOAL_NAME Because the Goal GOAL_NAME was Canceled**.
6. Save the document.
7. Proceed to the task **Previewing the Document**.

### Previewing the Document

Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

1. In the Ribbon, open the BI Publisher tab and click **Sample XML** within the Load Data group.
2. Browse to and select the PerformanceGoalNotificationsDM_.xml file you downloaded to import sample data from the data model.
3. In the **Data Loaded Successfully** dialog box, click **OK**.
4. At the top of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<? import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:C:///Template_Directory/Workflow Notification Subtemplate.rtf?>`.
5. From the BI Publisher tab in the Ribbon, click **HTML** in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the BI Publisher tab in the Ribbon, click **Validate Template** in the Tools group.
8. Also in the Tools group, click **Check Accessibility**.
9. Save your changes in Word.

### Adding Data Model Attributes to the Template

In this task, you add to the report template attributes that exist in the predefined data model. You will add the Goal ID and Category Meaning data model attributes to the template.

1. Open the UpdatedPerformanceGoalNotifications.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Select the BI Publisher tab.
3. In the Load Data section, click **Sample XML**.
4. In the dialog box to select XML data that appears, browse to open the PerformanceGoalNotificationsDM_.xml file you saved in the Exporting the Data Model XML File task and click **Open**.
5. In the **Data loaded successfully** dialog box, click **OK**.
6. Scroll to the **Aligned Goal Canceled** notification.
7. Place the cursor after **Goal Name** and press the Enter key.
8. On the new line, enter **Goal ID**.
9. Place the cursor after the data code **GOAL_NAME** and press the Enter key to enter a new line.
10. On the BI Publisher tab, in the Insert section, click the **123 Field** button to open the **Field** dialog box.
11. In the GOALDETAILS folder, select **GOAL_ID** and click **Insert**. The field appears in the document.
12. Place the cursor after the data code **Goal Description** and press the Enter key.
13. On the new line, enter **Goal Category**.
14. Place the cursor after the data code **DESCRIPTION** and press the Enter key to enter a new line.
15. On the **Field** dialog box, in the GOALDETAILS folder, select **CATEGORY_MEANING** and click **Insert**. The field appears in the document.
16. Click **Close** to return to the PerformanceGoalNotifications.rtf template.
17. Preview the template using the steps in the Previewing the Document task.
18. Save and close the document.
19. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

**Uploading the Modified Report Layout to the Oracle BI Publisher Catalog**

You must perform this task to use the modified report layout for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click **Catalog**
3. On the Catalog page, in the Folders section, expand **Shared Folders > Custom > Human Capital Management** and select Workflow Notifications.
4. Under the **PerformanceGoalNotificationsReport**, click **Edit**.
5. On the Performance Goal Notifications Data Model page, on the right side of the page, click **Add New Layout** to open the page with the Create Layout and Upload or Generate Layout sections.
6. In the Upload or Generate Layout section, click the **Upload** icon.
7. In the **Upload Template File** dialog box, in the **Layout Name** field, enter **Updated Performance Goal Notifications Template**.
8. In the **Template File** field, browse for the modified **UpdatedPerformanceGoalNotificationsTemplate.rtf** template on your local drive, select the template, and click **Open**.
9. In the **Upload Template File** dialog box, from the **Type** list, select **RTF Template**.
10. From the **Locale** list, select **English (United States)**.
11. Click **Upload** to open the **Processing** dialog box and return to the Performance Goal Notifications Data Model page.
12. On the right side of the page, click **View a list** to open the Layout page.
13. In the row for the **Updated Performance Goal Notifications Template**, select the **Default Layout** check box.
14. On the right side of the page, click the **Save Report** icon.

**Related Topics**

- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Using the Customize Option for Predefined Reports: Points to Consider

**Configuring Career Development Notifications Using Reports: Worked Example**

This example shows how to configure workflow email and in-app notifications for the career development business process using Oracle Business Intelligence (BI) Publisher reports. You use Microsoft Word to edit the .rtf template used for notifications. You can modify the BI Publisher templates only if you have the BI Administrator role.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which template do I update?</td>
<td>CareerDevelopmentFYINotification, for changes to worker development goal content</td>
</tr>
<tr>
<td>Do I add prompts and headers to the template?</td>
<td>Yes</td>
</tr>
<tr>
<td>Do I add data model attributes to the template?</td>
<td>Goal ID</td>
</tr>
</tbody>
</table>
Summary of the Tasks

Configure a career development notification by:

1. Exporting the data model XML file.
2. Downloading the report layout template.
3. Editing prompts and headers in the template.
4. Previewing the document.
5. Adding data model attributes to the template.
6. Uploading the modified report layout to the BI Publisher catalog.

If you only want to add or edit prompts and headers in the template, use tasks 1, 2, 3, 4, and 6. To only add data model attributes to the template, use tasks 1, 2, 4, 5, and 6.

Prerequisites

2. Download and install the Template Builder for Word to use Microsoft Word to edit the layout templates. To download, install, and set up Template Builder for Word, see Creating RTF Templates by Using BI Publisher 11g Template Builder for Word: http://www.oracle.com/webfolder/technetwork/tutorials/obe/fmw/bi/bip/tb4word/tbwordbip.htm.
3. To preview the configured templates, download a local copy of the subtemplate that applies to your custom own report layout template:
   - Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
   - Click Catalog.
   - In the BI catalog, go to Shared Folders > Common Content > Templates for the predefined subtemplate.
   - Click Edit for Workflow Notification Subtemplate.
   - In the Templates section, click the link in the Locale column.
   - Save the subtemplate .rtf file to your computer.
4. Click Catalog to open the Catalog page.

Exporting the Data Model XML File

In this task, you export the XML file that includes the data model attributes predefined for the notifications. Perform this task to enable previewing your modified template. This task is also required if you intend to add data model attributes to the template.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog to open the Catalog page.
3. In the Folders section, expand Shared Folders > Human Capital Management > Workflow Notifications and select Data Models to display the data models in the right pane.
Note: To ensure that all data sets include requested elements with null values in the output XML data, do the following:
- In the Data Model section, select Properties.
- In the Properties section, select Include Empty Tags for Null Elements.
- In the Data Model section, select Data Sets.

Note: To add data model attributes to the template, perform steps 5 and 6. Otherwise, skip to step 7.

5. Click the Data tab.
6. Enter the following attributes for an existing goal that are key attributes and enable you to pull in all the goal attributes:
   - GoalID
   - NotificationType
7. Click View to see the sample data in the report, and all the available attributes.
8. Click Export to open the Opening CareerDevelopmentFyiDM dialog box.
9. Select Save File and click OK.
10. Save the CareerDevelopmentFyiDM_.xml file to a local drive.

Downloading the Report Layout Template
In this task, you create a copy of the report layout template in the Custom folder, and download a copy of the template to your local hard drive to modify it.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator role to open the Oracle Business Intelligence Home page.
2. Click Catalog to open the Catalog page.
3. In the Folders section, expand Shared Folders > Human Capital Management and select Workflow Notifications to display the templates in the right pane.
4. Under CareerDevelopmentFYINotification, click More, and then select Customize. A copy of the CareerDevelopmentFYINotification is created automatically in the Custom folder.
6. Save the template to your local drive with the name UpdatedCareerDevelopmentFYINotificationLayout.rtf to distinguish it from the original template.

Editing Prompts and Headers in the Template
To modify workflow email and in-app notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word.

Note: The exact steps can vary depending on your version of Microsoft Word.

1. Open the UpdatedCareerDevelopmentFYINotificationLayout.rtf template in Microsoft Word with the Template Builder installed, if not already open. The document contains all notifications for the career development business process except approval notifications.
2. Scroll to the notification with the header Development Goal Added.
3. Place your cursor at the end of the Development Goal Added header.
4. Enter to Your Development Plan. The text now reads: Development Goal Added to Your Development Plan.
5. Place the cursor at the end of the text PPERFORMERNAME added development goal GOAL_NAME for you.
6. Enter a new sentence: You can access the goal to track your development.
7. Save the document.
Previewsing the Document

Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the emails sent to users.

1. In the Ribbon, open the BI Publisher tab and click Sample XML within the Load Data group.
2. Browse to and select the CareerDevelopmentFyiDM_.xml file you downloaded to import sample data from the data model.
3. In the Data Loaded Successfully dialog box, click OK.
4. At the top of the document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<? import:xdoxs://Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:C:///Template_Directory/Workflow Notification Subtemplate.rtf?>`.
5. From the BI Publisher tab in the Ribbon, click HTML in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the BI Publisher tab in the Ribbon, click Validate Template in the Tools group.
8. Also in the Tools group, click Check Accessibility.
9. Save your changes in Word.

Adding Data Model Attributes to the Template

In this task, you add to the report template attributes that exist in the predefined data model. You will add the Goal ID and Category Meaning data model attributes to the template.

1. Open the UpdatedCareerDevelopmentFYINotificationLayout.rtf template in Microsoft Word with the Template Builder installed, if not already open.
2. Select the BI Publisher tab.
3. In the Load Data section, click Sample XML.
4. In the dialog box to select XML data that appears, browse to open the CareerDevelopmentFyiDM_.xml file you saved in the Exporting the Data Model XML File task and click Open.
5. In the Data loaded successfully dialog box, click OK.
7. Place the cursor after the sentence: PPERFORMERNAME added development goal GOAL_NAME for you. and press the Enter key.
8. On the new line, enter Goal ID:
9. Enter a space after Goal ID:
10. On the BI Publisher tab, in the Insert section, click the 123 Field button to open the Field dialog box.
11. In the DATA_DS folder, select PGOALID and click Insert. The field appears in the document.
12. Click Close to return to the UpdatedCareerDevelopmentFYINotificationLayout.rtf template.
13. Preview the template using the steps in the Previewing the Document task.
14. Save and close the document.
15. Proceed to the task Uploading the Modified Report Layout to the Oracle BI Publisher Catalog.

Uploading the Modified Report Layout to the Oracle BI Publisher Catalog

You must perform this task to use the modified report layout for notifications.

1. Sign in to the Oracle Business Intelligence Publisher server with the BI Administrator Role to open the Oracle Business Intelligence Home page.
2. Click Catalog to open the Catalog page.
3. In the Folders section, expand Shared Folders > Custom > Human Capital Management and select Workflow Notifications.
5. On the CareerDevelopmentFYINotification Data Model page, on the right side of the page, click Add New Layout to open the page with the Create Layout and Upload or Generate Layout sections.
6. In the Upload or Generate Layout section, click the Upload icon.
7. In the **Upload Template File** dialog box, in the **Layout Name** field, enter **Updated Career Development Notifications Template**.
8. In the **Template File** field, browse for the modified **UpdatedCareerDevelopmentFYINotificationLayout.rtf template** on your local drive, select the template, and click **Open**.
9. On the **Upload Template File** dialog box, from the **Type** list, select **RTF Template**.
10. From the **Locale** list, select **English (United States)**.
11. Click **Upload** to open the **Processing** dialog box.
12. On the CareerDevelopmentFYINotification Data Model page, on the right side, click **View a list** to open the Layout page.
13. In the row for the **Updated Career Development Notifications Template**, select the **Default Layout** check box.
14. On the right side of the page, click the **Save Report** icon.

**Related Topics**
- Setting Up for RTF and Excel Report Layout Templates: Procedure
- Using the Customize Option for Predefined Reports: Points to Consider

**Previewing Changes to Layout Templates for Workflow Notifications: Procedure**

To modify workflow notifications, you edit a local copy of the .rtf report layout templates in Microsoft Word. Before uploading the .rtf files to the business intelligence (BI) catalog, you should preview the output with the changes you made. You can avoid uploading a broken report that displays an error in the notifications sent to users.

> **Note:** The exact steps can vary depending on your version of Microsoft Word.

**Prerequisites**
- Generate sample report data from the data model used for the report, and save the .xml file to your computer.
- Download a local copy of the subtemplate that applies to your own report layout template:
  - In the BI catalog, expand **Shared Folders > Custom > Common Content > Templates** if you’re using a modified subtemplate, or **Shared Folders > Common Content > Templates** for the predefined subtemplate.
- Click **Edit** for Workflow Notification Subtemplate.
- In the Templates section, click the link in the Locale column.
- Save the subtemplate .rtf file to your computer.

**Previewing Output**

To generate sample output from a local layout template:
1. Open your .rtf report layout template in Microsoft Word and make your edits.
2. On the ribbon, open the BI Publisher tab and click **Sample XML** within the Load Data group.
3. Select the .xml file you downloaded to import sample data from the data model.
4. At the beginning of your .rtf document, replace the path with the location of the downloaded subtemplate file on your computer. For example, change `<?import:xdoxsl:///Common Content/Templates/Workflow Notification Subtemplate.xsb?>` to `<?import:file:///C:/Template_Directory/FinFunWorkflowNotificationSub.rtf?>`.
5. From the BI Publisher tab on the ribbon, click **HTML** in the Preview group.
6. If the preview reflects your changes as expected, then change the path back to the original location.
7. From the BI Publisher tab on the ribbon, click Validate Template in the Tools group.
8. Also in the Tools group, click Check Accessibility.
9. Save your changes in Word.

Related Topics
- Generating Sample Report Data: Procedure

FAQs for Analyses and Dashboards

What are subject areas, dimensions, attributes, facts, and metrics?

Information for analysis is grouped into related functional areas called subject areas, which contain fact and dimension folders with attributes and facts used to create analyses.

Subject area folders include dimension and fact folders. Dimension folders include the grouping of dimensional attributes for the subject area. Columns (such as date of birth or name) which are grouped under a dimension are known as attributes. Fact folders contain numeric values, also called measures or metrics.

Dimension folders are often placed before fact folders in a subject area. Metrics can be combined with dimensional attributes for multi-dimensional analysis.

What's the relationship between dimensions and fact in a subject area?

A subject area is based around a single fact. The dimensions are all related to each other through the fact only. The fact is automatically included in any query that is created, even if none of the measures in the fact appear in the analysis.

What's a common dimension?

A common dimension is shared across multiple subject areas. For example, Time, Department, and Location are common dimensions. When constructing a cross-subject area analysis, only common dimensions can be used.

How can I determine which dimensions are shared across two subject areas?

If the dimensions exist in both subject areas, they are common dimensions, and are often among the top folders in a subject area. You can join any subject areas you have access to in Answers, but analyses are subject to the normalized data structure. Unless the underlying tables are joined by design, joining subject areas in Answers results in errors.
How can I identify subject areas to create analyses?
All OTBI subject area names end with the words "Real Time".

Can I change the columns in subject areas?
You can use only the available subject areas and their dimensions and facts. You can use other The data elements that are provided out of the box are the only ones that the customers can make use of. You can potentially use BI-enabled flexfields to analyze any column in the transactional tables.

Do analyses query transactional tables to display data?
Analyses run real-time queries of transactional tables through View Objects. Oracle Fusion data security, flexfields, user interface hints, lists of values, and other metadata are delivered through the View Objects.

What's a dashboard?
A dashboard is a container page to display analyses, reports, and other objects. Administrators can create shared dashboards for groups of users with common responsibilities or job functions. Personalized views can be created based on a user’s permissions.
6 Reports Modification

Oracle Business Intelligence Publisher: Overview

Oracle Business Intelligence (BI) Publisher allows you to author, generate, and deliver all types of highly formatted documents and operational reports. You can use familiar office desktop tools to create rich text format (.rtf) documents and reports against any data source. You can view reports, schedule them to run, and distribute them to predefined destinations.

A BI Publisher report consists of one or more .rtf layouts, a reference to a data model, and a set of properties. A report may also include style templates and subtemplates, which allow reusability of functionality and maintain consistency of design. In the logical architecture depicted in the figure, the report includes a data model and a layout, and the layout references two style templates in the catalog which in turn reference subtemplates.

In the BI Publisher logical architecture, the data model accesses data sources and the layout and its optional style template and subtemplates determine the formatting of the report output, which can include email, print, fax, or files, and others. The layout is designed using common office applications, for example Microsoft Word and Excel and Adobe Acrobat and Flash, among others.
Style Templates: Explained

A style template is a .rtf template that contains style information that can be applied to report layouts.

A style template is a .rtf template that contains style information that can be applied to report layouts at runtime to achieve a consistent look and feel across your enterprise reports. You associate a style template to a report layout in the report definition. Using a style template has the following benefits:

- Enables the same look and feel across your reports
- Enables consistent header and footer content, such as company logos, headings, and page numbering
- Simplifies changing elements and styles across all reports

Use style templates to define paragraph and heading styles, table styles, and header and footer content.

Paragraph and Heading Styles

When the named style is used in a report layout, the report layout inherits the following from the style template definition:

- font family
- font size
- font weight (normal, bold)
- font style (normal, italic)
- font color
- text decoration (underline or strike through)

Table Styles

Style elements inherited from the table style definition include:

- font style
- border style
- line definition
- shading
- text alignment

Header and Footer Content

The header and footer regions of the style template are applied to the report layout. This includes images, dates, page numbers, and any other text-based content. If the report layout also includes header and footer content, then it is overwritten.
Subtemplates: Explained

A subtemplate is a piece of formatting functionality in .rtf or .xsl format that can be defined once and used multiple times within a single layout template or across multiple report layout template files. Rich Text Format (RTF) subtemplates are easy to design using native features in Microsoft Word, while subtemplates using Extensible Stylesheet Language (XSL) can be used for complex layout and data requirements. Both .rtf and .xsl subtemplates are stored in the business intelligence catalog as a subtemplate object, and both can be called from .rtf layout templates.

Some common uses for subtemplates include:

- Reusing a common layout or component (such as a header, footer, or address block)
- Handling parameterized layout
- Handling dynamic or conditional layouts
- Handling lengthy calculations or reusing formulas

RTF Subtemplates

An RTF subtemplate is an RTF file that consists of one or more `<?template:?>` definitions, each containing a block of formatting or commands, that when uploaded to Business Intelligence (BI) Publisher as a subtemplate object in the catalog can be called from within another RTF template.

XSL Subtemplates

An XSL subtemplate is an XSL file that contains formatting or processing commands in XSL for the Business Intelligence Publisher formatting engine to execute. Use an XSL template to include complex calculations or formatting instructions not supported by the RTF standard.

Creating and Editing Reports: Explained

Use reports to generate and print documents for internal operations, external business transactions, or legal requirements. To meet specific requirements, you must create or edit reports to capture different data, or present data in another way.

Report Components

Each report has components that you can modify, as described in this table:

<table>
<thead>
<tr>
<th>Report Component</th>
<th>Description</th>
<th>Tool for Modifying</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data model</td>
<td>Defines the data source, data structure, and parameters for the report. Multiple reports can use the same data model. Each report has one data model.</td>
<td>Data model editor in the application</td>
</tr>
</tbody>
</table>
What You Can Create or Edit
This table gives just a few examples of creating or editing reports.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the layout of a report.</td>
<td>Add your company logo to the report output.</td>
</tr>
<tr>
<td>Add a new layout to a report.</td>
<td>Design a new layout template that provides less detail than the existing template.</td>
</tr>
<tr>
<td>Edit a data model.</td>
<td>Add two fields to the data model used by a report so you can add those new fields to a layout for the report.</td>
</tr>
<tr>
<td>Create a new report based on a new data model.</td>
<td>Create a new data model based on data from an external system, and create reports using the data model.</td>
</tr>
</tbody>
</table>

Accessing Report Components to Modify: Points to Consider

To create or edit reports, you must access the business intelligence (BI) catalog. In the catalog, objects of type Report represent the report definition, which includes report properties and layouts. Data models are separate objects in the catalog, usually stored in subfolders called Data Models.

Accessing the BI Catalog

You can access the BI catalog in any of the following ways:

- In the Reports and Analytics pane, click **Browse Catalog** to open the BI catalog, and find your report or data model in the Folders pane.
- In the Reports and Analytics pane, find your report and select **More** to go to the report directly in the catalog. The data model associated with the report should be in the Data Models subfolder within the same folder as the report.
- Sign in to the application directly (for example: **http://host:port/analytics/saw.dll**) to open the catalog.
• Sign in to the BI server directly (for example: http://hostname.com:7001/xmlpserver) to open the catalog.
  o Alternatively, once you are in the catalog using another method, for example, through the Reports and Analytics pane, change the final node of the URL. For example, change (http://host:port/analytics/saw.dll) to xmlpserver. So the URL you use would be: http://host:port/xmlpserver.

Predefined Reports
A special Customize option is available only:
• For predefined reports, not data models.
• Through direct access to the BI server using the /xmlpserver URL. When you find your report in the BI catalog, select Customize from the More menu.

The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom folder within the catalog. The new report is linked to the original, so that when users open or schedule the original, they are actually using the copied version.

If you don't have access to the Customize option or don't want the original version linked to the new report, make a copy of the predefined report and save it in the Custom folder.

Predefined Data Models
Don't edit predefined data models. Instead, copy the data model into the Custom folder and edit the copy. You can't create a new data model based on the transactional tables.

Related Topics
• Saving Analytics and Reports: Points to Consider
• What Happens to Modified Analytics and Reports When an Update Is Applied?

Using the Customize Option for Predefined Reports: Points to Consider
The Customize option automatically creates a copy of a predefined report and stores it in the Shared Folders > Custom within the business intelligence (BI) catalog. The copy includes the report definition, folder structure, and original report permissions, and is linked internally to the original report. You can edit the copy of the report, leaving the original report intact. When users open or schedule the original report, they are actually using the newer version.

Benefits of the Customize Option
In addition to conveniently copying a predefined report to the Custom folder, the Customize option:
• Makes it unnecessary to update processes or applications that call the report. For example, if the original report is set up to run as a scheduled process, you don’t need to change the setup. When users submit the same scheduled process, the newer report runs instead of the original.
• Automatically copies the security settings of the original report.
• Removes the risk of patches overwriting your edits. If a patch updates the original report, the newer report is not updated in any way.
Note: The report still references the original data model. The data model is not copied. A patch that updates the data structure of the data model might affect your report.

Accessing the Customize Option

To access the Customize option:

2. In the Folders pane, select the predefined report.
3. Select Customize from the More menu for the report.
4. The copied report in the Custom folder opens, so proceed to edit this report.

To edit the copied report again later, you don’t need to be in the BI server. Just go to the BI catalog and either:

- Select the Customize or Edit option for the original report.
- Find your report in the Custom folder and select Edit.

Related Topics

- Saving Analytics and Reports: Points to Consider
- What Happens to Modified Analytics and Reports When an Update Is Applied?

Links Between Original and Modified Reports: Points to Consider

The Customize option for predefined reports creates a copy of the report that is linked to the original. Consider the following points when you work with both the original and modified versions.

Maintaining the Link Between Reports

The link between the predefined and modified report is based on the name of the modified report and its location within the Custom folder in the business intelligence (BI) catalog.

- If you manually create a report with the same name as a predefined report, and give it the same folder path under the Custom folder, then the new report becomes a version of the original. It would be as if you had used the Customize option to create a copy of the predefined report.
- You can edit the report so that it uses a different data model. But if the original data model is updated later, then your newer report doesn’t benefit from the change.

Caution: The link to the original report breaks if you rename the modified or original report.
Tasks Performed on Original Reports
This table describes what happens when you use the original report and a corresponding copied report exists.

<table>
<thead>
<tr>
<th>Task Performed on the Original Report</th>
<th>Result When There Is a Copied Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the copied report.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Creates a report submission for the copied report.</td>
</tr>
<tr>
<td>Edit</td>
<td>Edits the copied report.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the original report only. If you delete the copied report, the original report is not deleted.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the original report.</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>Cuts and pastes the original report.</td>
</tr>
<tr>
<td>Rename</td>
<td>Renames the original report. The copied report name is not changed.</td>
</tr>
</tbody>
</table>

⚠️ **Caution:** This breaks the link between the original and copied reports.

| Download                              | Downloads the copied report.         |
| Customized                            | Edits the copied report.             |
| History                               | Opens the job history of the copied report. |

**Related Topics**
- Saving Analytics and Reports: Points to Consider
- What Happens to Modified Analytics and Reports When an Update Is Applied?

## Layouts

### Creating and Editing Report Layouts: Overview

The layout determines what and how data is displayed on report output. Each report has at least one layout template. This topic describes the following aspects of report templates:

- Layout templates
- Layout template types
• Overall process of managing layouts
• Deleting layout templates

Layout Templates
To modify a layout, you edit the layout template, which:

• Defines the presentation components, such as tables and labeled fields.
• Maps columns from the data model to these components so that the data is displayed in the right place.
• Defines font sizes, styles, borders, shading, and other formatting, including images such as a company logo.

Layout Template Types
There are a few types of template files to support different report layout requirements.

• RTF: Rich text format (RTF) templates created using Microsoft Word.
• XPT: Created using the application's layout editor, these templates are for interactive and more visually appealing layouts.
• eText: These templates are specifically for Electronic Data Interchange (EDI) and electronic funds transfer (EFT) information.

You can also create and edit other types of templates using Adobe PDF, Microsoft Excel, Adobe Flash, and XSL-FO.

Overall Process to Create or Edit Layouts
Editing or creating report layout, for example using Microsoft Word or the layout editor, involves making the actual changes to the template file. But that task is just one part of the entire process for modifying layouts.

1. Copy the original report and save the new version in Shared Folders > Custom in the business intelligence (BI) catalog. You create or edit templates for the new copy of the report.

   Tip: You can use the Customize option if the original is a predefined report.

2. Review report settings for online viewing.
3. Generate sample data for the report.
4. Edit or create the layout template file.
5. Upload the template file to the report definition. Skip this step if you're using the layout editor.
6. Configure the layout settings.

Deleting Layout Templates
To remove a layout template for a report:

1. Select your report in the BI catalog and click Edit.
2. In the report editor, click View a list.
3. Select the layout template and click Delete.
Making Reports Available for Online Viewing: Procedure

Some reports are set up so that you can only view them through another application or submit them as scheduled processes. To view your report online while you’re editing it, you must define a few settings. When you’re done editing your report, make sure that you reset these settings as needed.

Updating Report Properties

1. Select your report in the business intelligence catalog and click Edit.
2. In the report editor, click Properties.

Updating Layout Settings

1. Back in the report editor, click View a list.
2. Make sure that the View Online check box is selected.

Generating Sample Report Data: Procedure

Depending on the type of report layout changes you’re making, sample data can be required or optional. You generate sample data, and then load it for use with your layout so that you can map data fields to layout components. For example, for the Start Date table column in your layout, you can set it so that the data displayed in that column comes from the Start Date field in the sample data.

You can generate sample data from the:

- Report data model
- Report viewer
- Scheduler

Generating Sample Data from the Data Model

Follow these steps:

1. Select your data model in the business intelligence (BI) catalog and click Edit. Alternatively:
   a. In the catalog, find the report to generate sample data for and click Edit.
   b. Click the data model name in the report editor.
2. In the data model editor, click View Data.
3. Enter values for any required parameters, select the number of rows to return, and click View.
4. To save the sample data to the data model, click Save As Sample Data.
   If you’re designing a .rtf template, click Export to save the file locally.
5. Save the data model.

Saving Sample Data from the Report Viewer

For reports that are enabled for online viewing, you can save sample data from the report viewer:

1. Select the report in the BI catalog.
2. Click **Open** to run the report in the report viewer with the default parameters.
3. On the Actions menu, click **Export**, then click **Data**.
4. Save the data file.

### Saving Sample Data from the Scheduler

For reports that are enabled for scheduling (not necessarily as a scheduled process), you can save sample data from the scheduler:

1. Select the report in the BI catalog.
2. Click **Schedule**.
3. On the General tab, enter values for any report parameters.
4. On the Output tab, ensure that **Save Data for Republishing** is selected.
5. Click **Submit**.
7. On the global header, click **Open**, then click **Report Job History**.
8. Select your report job name in the Job Histories table.
9. On the details page, under Output and Delivery, click the **XML Data Download** icon button.

### Layout Templates

#### Creating and Editing Report Layout Templates Using the Layout Editor: Procedure

The layout editor in the application provides an intuitive, drag-and-drop interface for creating pixel-perfect reports with PDF, RTF, Excel, PowerPoint, and HTML output. The layout template files you create with this tool have an `.xpt` extension. The layout editor tool is the only editing tool that provides dynamic HTML output. Users can interact with this output in a browser, for example by sorting, applying filters, and so on.

**Prerequisite**

Make sure that sample data is generated from the data model that your report is using.

**Using the Layout Editor**

To create or edit XPT templates:

1. Select the report in the business intelligence (BI) catalog and click **Edit**.
2. In the report editor, click **Edit** to update a template.
   - Or, click **Add New Layout** and select a template type under the Create Layout section.
3. Create or edit the layout.
4. Click **Save** to save the layout to the report definition.

#### Setting Up for RTF and Excel Report Layout Templates: Procedure

You can use Microsoft Word or Microsoft Excel to create or edit RTF and Excel layout templates, in addition to the layout editor in the application. If you use Word or Excel directly, you must download and install the appropriate add-in so that the Microsoft application has the features you need to design report layouts.

**Note:** If you’re designing a new layout for your report, consider using the layout editor instead unless you are an experienced layout designer.

**Installing the Add-In**

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas.
2. Click the **Browse Catalog** button.
3. Click **Home**.
4. Under the Get Started pane, click **Download BI Desktop Tools**.
5. Select the add-in for the type of template you’re working with.
   - **Template Builder for Word**: RTF templates
   - **Analyzer for Excel**: Excel templates
6. Save and then run the installer.

### Creating and Editing RTF Report Layout Templates: Procedure

An RTF template is a rich text format file that contains the layout instructions to use when generating the report output. Use Microsoft Word with the Template Builder for Word add-in to design RTF templates.

**Prerequisites**

Install the Template Builder for Word add-in, and generate sample data.

**Using Template Builder for Word**

To modify an RTF template:

1. If you are editing an existing layout:
   a. Select your report in the business intelligence catalog and click **Edit**.
   b. In the report editor, click the **Edit** link of the layout to download the RTF file.

   If you are creating a new layout, skip this step.

2. Open the downloaded RTF template file in Microsoft Word. Or, if you’re creating a new template, just open Microsoft Word.
3. Load the sample data that you generated.
4. Edit or create the layout template.
5. Save the file as Rich Text Format (RTF).

### eText Report Layout Templates: Explained

An eText template is an RTF-based report template that is used for Electronic Funds Transfer (EFT) and Electronic Data Interchange (EDI). The template is applied to an input XML data file to create a flat text file that you transmit to a bank or other organizations. Use Microsoft Word to create or edit eText templates.

**File Format**

Because the output is for electronic communication, not printing, you must follow specific format instructions for exact placement of data on the template. You design eText templates using tables.

- Each record is represented by a table.
- Each row in a table corresponds to a field in a record.
- The columns of the table specify the position, length, and value of the field.

**Special Commands**

You must set up special handling of the data from the input XML file. This table describes the two levels of handling and where you declare the corresponding commands.
Oracle Human Capital Management Cloud
Creating and Administering Analytics and Reports for HCM

Chapter 6
Reports Modification

<table>
<thead>
<tr>
<th>Level</th>
<th>Example</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Character replacement</td>
<td>Declare global commands in separate setup tables.</td>
</tr>
<tr>
<td></td>
<td>Sequencing</td>
<td></td>
</tr>
<tr>
<td>Record</td>
<td>Sorting</td>
<td>Declare functions in command rows, in the same table as the data.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Level</th>
<th>Example</th>
<th>Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Uploading the Layout Template File to the Report Definition: Procedure

If you’re creating or editing a report layout using the layout editor, the layout is automatically saved to the report definition, so you can skip this step. For all other layout types, for example RTF, upload the template file to the report definition after you’re done making layout changes.

Uploading the Template File

1. Select your report in the business intelligence catalog and click **Edit**.
2. In the report editor, click **View a list**.
3. In the table that lists the layouts, click **Create**.
4. Under **Upload or Generate Layout**, click **Upload**.
5. In the Upload Template File dialog box:
   a. Enter a layout name.
   b. Browse for and select the layout template file that you created or edited.
   c. Select the template file type.
   d. Select the locale, which you can’t change once the template file is saved to the report definition.
   e. Click **Upload**.
6. Save the report definition.

Configuring Layout Settings for Reports: Procedure

As part of creating or editing layout, you can set report properties related to layout. These settings determine, for example, which layouts users can choose from when viewing or scheduling the report. The settings apply only to your report.

Setting Layout Properties

1. Select your report in the business intelligence catalog and click **Edit**.
2. In the report editor, click **View a list**.
3. Set layout properties, some of which are described in this table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Formats</td>
<td>Depending on the requirements for a report, you may want to limit the output file formats (for example, PDF or HTML) that users can choose. The available output formats vary depending on the template file type.</td>
</tr>
</tbody>
</table>
When multiple output formats are available for the report, the default output format is generated when users open the report in the report viewer.

When multiple layouts are available for the report, you must select a default layout to present it first in the report viewer.

Active layouts are available for users to choose from when they view or schedule the report.

Select this check box so that layouts are available to users when they view the report. Otherwise, the layout is available only for scheduling the report.

4. Click **Save Report**.

### Data Models

#### Modifying Data Models: Procedure

A data model defines where data for a report comes from and how that data is retrieved. If a data model can’t give you all the data that you need in your report, then you can either copy and edit an existing data model or create a new one. You must be a BI Administrator to create new data models.

#### Creating a Data Model

1. In the business intelligence (BI) catalog, click the **New** button and select **Data Model** under **Published Reporting**.
2. Optionally click the **Data Model** node in the Data Model pane to set properties for the data model.
3. Click the **Data Set** node in the Data Model pane to create or edit data sets, which determine where and how to retrieve data.
4. Click the **New Data Set** button and select a data set type. It’s best practice to use the BI repository as a data source, so you should select either:
   - **Oracle BI Analysis**: To use columns from a selected analysis.
   - **SQL Query**: To use a Query Builder tool to define what to use from the repository. Select **Oracle BI EE** as the data source.
5. Optionally, to limit the data included in the report output, click the **Parameters** node in the Data Model pane to define variables that users can set when they use the report.

> **Note:** The order of parameters is important if there are job definitions defined for reports that use your data model. If you change the order in the data model, you must also update the job definitions.

6. Optionally, define other components of the data model.
7. Click **Validate** to validate your data model. Errors and warnings pertaining to query performance are displayed. In case of errors in validation, the model is usable in development, but will not be available in production until errors are resolved.
8. Save your data model.
Editing a Data Model

1. To edit a predefined data model:
   a. Find the data model in the BI catalog and click **Copy**.
   b. Paste within **Shared Folders > Custom** in a subfolder that has a folder path similar to the folder that stores the original data model.
   c. For the data model you pasted, click **More**, and select **Edit**.
2. Optionally click the **Data Model** node in the Data Model pane to set properties for the data model.
3. Click the **Data Set** node in the Data Model pane to create or edit data sets.

Most predefined data models are of type SQL Query, and are set up to get application data from the following tables:

- **ApplicationDB_FSCM:** Financials, Supply Chain Management, Project Management, Procurement, and Incentive Compensation
- **ApplicationDB_CRM:** Sales
- **ApplicationDB_HCM:** Human Capital Management

4. Perform steps 5 through 8 from the preceding Creating a Data Model task, as needed.

Related Topics
- Setting Reports Up to Run as Scheduled Processes: Points to Consider
- Data Structure for Analytics: Explained

Creating a New Data Model for an HCM Report: Worked Example

This example shows how to create a data model for an Oracle Business Intelligence Publisher report. In this example, you create a data model using an absence by department analysis that you created previously.

Creating a Data Model

1. Navigate to the Reports and Analytics work area and click **Browse Catalog** to open the Oracle Business Intelligence Catalog.
2. On the OBI EE home page under Create, Published Reporting, click **More** and select **Data Model**.
3. On the Diagram tab, click **New Data Set** and select **Oracle BI Analysis**.
4. In the New Data Set - Oracle BI Analysis window enter a name for your data model.
5. In the Oracle BI Analysis field, click **Search**.
6. In the Oracle BI Catalog window, click **Users**.
7. Click the name of the person who created the analysis.
8. Locate and select the absence by department analysis that you have previously created.
9. In the **Time Out** field, enter 120.
10. Click **OK**.
11. Click the **Structure** tab.
12. In the **XML Tag Name** field for the Department Name, replace the default value with DEPT_NAME, and replace the default value in the Display Name with Department.
13. In the **XML Tag Name** field for the Absence Reason, replace the default value with ABSENCE_REASON, and replace the default value in the Display Name with Reason for Absence.
14. In the **XML Tag Name** field for the Assignment Absences, replace the default value with NUMBER_ABSENCES, and replace the default value in the Display Name with Number of Absences.
15. Click the **Data** tab.
16. On the Data tab, click **View**.
17. View the report structure and click **Save As Sample Data**.
18. Click **OK**.
19. In the upper-right corner, click **Save**.
20. In the Save As window, select **My Folders**, and enter Absence by Department Data Model.

### New Reports

**Creating Reports: Procedure**

Create a report when the predefined reports don’t provide the data you need. Or, if you want to use a predefined data model, and also want to change other aspects of the report other than layout. Save your report to **Shared Folders > Custom** in the business intelligence catalog. Saving content in the Custom folder is the only way to ensure that the content is maintained upon upgrade.

**Creating a Report**

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas.
2. Click **Create** and select **Report**.
3. Select the data model to use as the data source for your report.

**Note:** Be sure that the data model you select has been validated. If you select a data model that has not been validated or has errors, when the report is run it will error indicating that the data model has not been validated or has an invalid status. To override this warning for a report, select the Ignore Data Model Validation Error option in the report properties.

4. Continue with the wizard to create the report layout, or choose to use the layout editor and close the wizard.
5. Define the layout for the report.
6. Click the **Properties** button in the report editor to set specific formatting, caching, and processing options for your report, including overriding data model validation errors.

**Setting Up Access**

You or your administrator can:

- Create a job definition so that users can run your report as a scheduled process.
- Set up the report for scheduling in the Reports and Analytics pane.
- Secure general access to your report and its job definition, if any.
Creating an Absence by Department Report: Worked Example

This example demonstrates how to create an Oracle Business Intelligence Publisher report. In this example, you use a data model that you created using an Oracle Transactional Business Intelligence analysis for reporting on absence data by department.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decision to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which data model to use?</td>
<td>Use the Absence by Department data model that you previously created.</td>
</tr>
<tr>
<td>Which layout options to use?</td>
<td>Select Landscape and select Chart and Pivot table.</td>
</tr>
<tr>
<td>Add any additional charts to the report?</td>
<td>Yes. Add a chart with the same configuration as the graph. Add this chart above the graph. When you click the different bars in the chart, it filters the graph by that criteria.</td>
</tr>
<tr>
<td>Are filters needed for the report?</td>
<td>Yes. Add filters to the chart, graph, and table to exclude records where the Reason for Absence is blank.</td>
</tr>
<tr>
<td>Is conditional highlighting needed?</td>
<td>Yes. Add conditional highlighting to the pivot table so that departments with 20 or more absences are highlighted in red.</td>
</tr>
</tbody>
</table>

Creating a Report

1. Click **Browse Catalog** to open the BI Catalog.
2. On the OBI EE home page, under Published Reporting, click **Report** in the Create region.
3. In the Create Report window, verify that Use **Data Model** is selected.
4. Click **Search** in the **Data Model** field.
5. In the Select Data Model window, select the absence by department data model that you created.
6. Click **OK**.
7. On the Create Report page, verify that the **Guide Me** option is selected, and click **Next**.
8. On the Create Report, Select Layout page, select **Landscape** for the layout.
9. Select the **Page Header** and **Page Footer** options.
10. Select the **Chart and Pivot Table** option.
11. Click **Next**.
12. On the Create Report, Create Chart page, drag **Number of Absences** and drop it onto the **Drop Value Here** box.
13. Drag **Reason for Absence** and drop it onto the **Drop Series Here** box.
14. Drag **Department** and drop it onto the **Drop Label Here** box.
15. Click **Next**.
16. On the Create Report, Create Table page, review the location of each element in the table to make sure it’s formatted correctly.

17. Click Next.

18. Select View Report, and then click Finish.

19. In the Save As window, save your report in My Folders, and name it Absence by Department Report.

20. Click OK.

21. The report appears.

Adding Additional Details to the Report

1. In the upper right corner of the Absence by Department Report tab, click Actions to view the options for exporting, editing, and so on.

2. Click Edit Report.

3. Click Edit.

4. On the Insert tab, select Chart.

5. Drag the Chart component down to the report area, and drop it directly below the report title.

   When you drag the chart component down to the report area, use the blue bar as a guide to decide where to drop the chart. Drop the chart when the blue bar is directly below the report title.

6. In the Data Source region, select Number of Absences, and drag and drop it onto the Drop Value Here box.

7. Click Reason for Absence and drag and drop it onto the Drop Label Here box.

8. Click the new graph. A yellow border appears.

9. Click the bottom right corner of the yellow border, and drag the corner to the right so that the graph occupies the entire page.

10. In the Filter options on the Chart tab, click Filter.

11. In the Filter window, select Reason for Absence from the Data Field menu.

12. In the Operator field, select is greater than or equal to from the drop-down list.

13. In the Value field, enter 0.

14. Click OK.

15. Toggle 3D Effect on and off and choose one of the settings, based on your preference.

16. Repeat steps 9 through 14 for the second graph.

17. Click the pivot table to refocus the page on the pivot table. The yellow border appears.

18. In the Filter options on the Table tab, click Filter.

19. In the Filter window, select Reason for Absence from the Data Field drop-down list.

20. In the Operator field, select is greater than or equal to from the drop-down list.

21. In the Value field, enter 0.

22. Click OK.

23. Click the cells in the Number of Absences column.

24. In the Conditional Formatting region of the Pivot Table Data tab, click Highlight.

25. In the Operator field, select is greater than or equal to from the drop-down list.

26. In the Value field, enter 20.

27. Click in the Background Color field.

28. In the Color Picker window, select Red (ff0000)

29. Click OK.

30. In the Highlight window, click OK.

31. Click Save to save the changes to your report.

32. Click Return.

33. Click View Report.
34. In the upper graph, click the different bars to see how the lower graph filters the results.

Related Topics

- Creating an Absences by Department Analysis: Worked Example
7 Analytics and Reports Management

Managing Folders

Creating Folders: Procedure

You manage analyses and reports in the business intelligence catalog, where you create folders to organize them.

Creating Folders

Follow these steps:

1. In the catalog, navigate to the desired location of the new folder in the Folders pane.
2. In the catalog toolbar, click New, and select Folder.
3. In the New Folder dialog box, enter the folder name, and click OK.

Addressing Automatically Created Folders

If conflicts are detected during upgrade, folders named backup_nnn are automatically created in the catalog. After reviewing and resolving any conflicts, Oracle recommends that you manually delete the backup folders from the catalog. You can contact your help desk to request an automated removal if you have a large number of folders to delete.

Setting Folder Permissions and Attributes: Procedure

Business intelligence catalog folder properties control folder permissions and other attributes. You can access the properties of any object or folder in the catalog to perform tasks such as viewing system information or changing attributes or ownership. All other users can only access and modify the properties of the objects that they create or own.

Setting Folder Properties

Follow these steps:

1. In the catalog, select the folder you want to assign properties to.
2. In the Tasks pane, click Properties.
3. In the Properties dialog box, select any of the options in the Attributes section:
   - Hidden: Specifies that the object is hidden.
   - System: Specifies that the object is a system object.
   - Read Only: Specifies that the object is read-only.
   - Do Not Index: Excludes the object from the index used by the full-text catalog search. Excluded objects do not display in the results of any full-text catalog search; the object can still be found using the basic catalog search.
4. Use the Ownership section to take ownership of a folder or object in the catalog. This area displays only if the proper privileges were assigned to the user, group, or role. Note that the owner of an object or folder can’t automatically access the object or folder.
   - Set ownership of this item: Click to become the owner of the folder or object.
   - Set ownership of this item and all sub items: Click to become the owner of the folder and any sub folders or sub items contained within the item. For example, if you click this link for a dashboard folder, then you take ownership of all of the dashboard’s components.

**Setting Folder Permissions: Procedure**

You can assign permissions on folders and other objects.

**Accessing and Setting Permissions**

You can set permissions or change ownership for any catalog object or folder. Nonadministrative users can access and modify the permissions of the objects that they create or own.

To set folder permissions:

1. In the catalog, select the folder or object.
2. In the Tasks pane click **Permissions**.
3. In the Permissions dialog box, the owner and any other users, roles, or groups with permissions are listed in the Permissions list. To add a user or role, click **Add users/roles** in the toolbar and search for users or roles to add them to the Selected Members list in the Add Application Roles, Catalog Groups and Users dialog box. To delete a user or role, select the account and role in the Permissions list and click **Delete selected users/roles**.
4. In the Permissions list, to set ownership for a user, select Custom in the Permissions drop-down list for the account, then select **Set Ownership** in the Custom Permissions dialog box and click **OK**. You can also select the **Owner** option for the user or role.
5. Use the Permissions drop-down list to set permissions for the object. Object permissions vary by object.
6. Use the Apply permissions to sub-folders option to assign permissions to the folder’s subfolders, and the Apply permissions to items within a folder to assign them to objects in the folder but not to subfolders.

**Using Briefing Books**

**Creating Briefing Books: Procedure**

A briefing book is a collection of updatable or static analyses or dashboard pages (which can contain reports). The static snapshots give you a picture of what’s going on at the time that the analysis or dashboard page is added to the briefing book. You can download briefing books as PDF or MHTML for viewing or printing, and share them with others. The PDF file includes a table of contents for the book. Like analytics and reports, briefing books are stored in the business intelligence (BI) catalog.

**Adding Content to New Briefing Books**

Follow these steps:

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas.
2. Click the **Browse Catalog** button.
3. Select your analysis, then click **More** and select **Add to Briefing Book**.
Or, find your dashboard and click Open.

4. Indicate if you want the analysis or dashboard results to change (Updatable) or not (Snapshot) whenever the briefing book is downloaded or rerun.

5. Click Browse.


Adding Content to Existing Briefing Books

Follow these steps:

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas.

2. Click Browse Catalog.

3. Select your analysis, then click More and select Add to Briefing Book.

Or, find your dashboard and click Open.

4. Indicate if you want the analysis or dashboard results to change (Updatable) or not (Snapshot) whenever the briefing book is downloaded or rerun.

Downloading and Editing Briefing Books

Follow these steps:

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas.

2. Click Browse Catalog to locate your briefing book.

You can find briefing books only in the BI catalog.

Related Topics

• Reports and Analytics Work Area and Panel Tab: Explained

Scheduling Analytics and Reports

Setting Reports Up to Run as Scheduled Processes: Points to Consider

You can create a job definition for predefined or custom reports so that users can run them as scheduled processes. Use the Define Custom Enterprise Scheduler Jobs task in the Setup and Maintenance work area to create job definitions. Otherwise, users can open reports (which are set up to be run online) through the Reports and Analytics pane, or open and schedule them from the business intelligence catalog.

General Job Definition Information

This table describes the general information to enter for your job definition.
### Field | What You Enter
---|---
Job Type | BIPJobType

**Report ID**
The path to the report in the catalog, starting with the folder beneath Shared Folders, for example: Custom/ `<Family Name>/` `<Product Name>/` `<Report File Name>` .xdo.<br>Make sure to include the .xdo extension for the report definition.

**Default Output**
A default output format.

---

### Parameters
You can define parameters to be available to users when they submit scheduled processes based on your job definition. When users run the scheduled process, the values they enter for the parameters:

- Are passed to the data model that the report is using.
- Determine the data to be included in the report.

The parameters that you define must be in the same order as parameters in the data model. For example, the data model has parameters in this order:

- `P_START_DATE`
- `P_END_DATE`
- `P_CURRENCY`

You create parameters as follows:

- Start Date
- End Date
- Currency

> **Note:** Because you define parameters using the list of values sources from the Define Custom Enterprise Scheduler Jobs task, you should not define lists of values in the data model.

### User Property
The only user property you must define is `EXT_PortletContainerWebModule`. Only lists of values associated with the application that you select are made available for parameters in this job definition.

**Related Topics**

- Modifying Data Models: Procedure
- Creating Reports: Procedure

### Setting Reports Up for Scheduling: Procedure
You can set up reports as scheduled processes, which means users can submit them from the Scheduled Processes and other work areas. If you want users to also submit these scheduled processes from the Reports and Analytics work area and panel tab, then you must configure properties for the corresponding reports.
Enabling a Report for Scheduling

To enable scheduling in the Reports and Analytics work area and panel tab:

1. In the Reports and Analytics work area or panel tab, edit the report in the business intelligence catalog.
2. Click Properties.
3. On the General tab in the Properties dialog box, enter the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Scheduler Job Package Name</td>
<td>The path for the job definition, for example: / oracle/apps/ess/&lt;product family&gt;/ &lt;product&gt;/ &lt;business area&gt;/ Jobs</td>
</tr>
<tr>
<td>Enterprise Scheduler Job Definition Name</td>
<td>The job definition name (not display name), for example: ABCDEFG</td>
</tr>
</tbody>
</table>

Related Topics

- Setting Up the Reports and Analytics Panel Tab: Procedure
- Accessing Report Components to Modify: Points to Consider

Scheduling Analytics and Briefing Books: Procedure

Analytics and briefing books can run based on a schedule that you define. You can set up other automated tasks, for example to deliver results to specific recipients or send notifications. You create what’s called an agent to set this all up for an analysis, dashboard, or briefing book. The agent itself is saved as an object in the business intelligence (BI) catalog.

Creating an Agent

1. Open the Reports and Analytics work area, or the Reports and Analytics panel tab if available in other work areas.
2. Click the Browse Catalog button.
3. Click New and select Agent in the Actionable Intelligence section.
4. Ensure that you enter information on the Delivery Content tab to specify the analysis, dashboard, or briefing book to run.
5. Save the agent in My Folders.

Note: To edit an agent, browse the BI catalog to find the agent.

Related Topics

- Reports and Analytics Work Area and Panel Tab: Explained

Scheduling Reports: Procedure

Reports can run based on a schedule that you define. You can set up other automated tasks, for example to deliver results to specific recipients or send notifications. You submit a report with the schedule and criteria for other automated tasks defined.
If a report is set up as a scheduled process, you submit the process as you would any scheduled process. You can schedule them from:

- Any work area where there is a link to the report.
- The Scheduled Processes work area, where you can submit all processes that you have access to.
- The Reports and Analytics work area or pane, if the report is set up for submission from there.

**Submitting a Report or Scheduled Process**

Follow these steps:

1. Open the Reports and Analytics work area, or the Reports and Analytics pane if available in other work areas where you can find the report.
2. Click the name of your report.
3. Click **Schedule** if the option is there. The report is set up as a scheduled process.
   a. Enter any parameters to avoid unnecessarily large results.
   b. Click **Advanced** to enter a schedule, deliver results to a specific destination (including e-mail or printer), or define criteria for sending notifications.
4. If you don’t see **Schedule**, then click **View**.
   a. Click the **Actions** button for the report and select **Schedule**.
   b. Enter information similar to step 3.

**Related Topics**

- Scheduled Processes: Explained
- Reports and Analytics Work Area and Panel Tab: Explained
- Managing Scheduled Processes That You Submitted: Points to Consider
- Submitting Scheduled Processes and Process Sets: Procedure

**Adding Analyses to Application Pages**

**Adding an Analysis to the Human Resources Dashboard: Worked Example**

This example shows how to add an analysis to the Human Resources dashboard. This dashboard is a page in the application, not a dashboard in the business intelligence (BI) catalog.

You can add predefined or modified analyses to any desktop page that you can personalize or modify.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which analysis do you want to add?</td>
<td>Position Occupancy.</td>
</tr>
</tbody>
</table>
Decisions to Consider | In This Example
--- | ---
Do you have to change the layout of the page? | Yes, to a two-column layout that is wider on the right side.

Note: Make sure that the analysis isn’t querying against a large volume of records. If the query is against many records, then the Human Resources dashboard can take a long time to open after you add the analysis.

The one- or two-column layout gives enough space to properly display analyses.

Do you want all or only one view of the analysis? | All views.

Are these changes for you only, or for all users of the Human Resources dashboard? | You only.

Adding an Analysis to the Human Resources Dashboard

1. Open the Human Resources dashboard.
2. Click your name in the global area and select Edit Current Page.
3. Click Change Layout and select Two columns, narrow left.
4. Click Add Content for the wider column.

The Reports and Analytics folder in the Add Content dialog box contains what’s in the BI catalog.
5. Click through the folders in the catalog until you see the name of the analysis, and click Add to include all views of the analysis.

If you instead click Open or Position Occupancy, you can select a specific view to add.
6. Click Close after you see the analysis added to the top of the wider column on the dashboard.
7. Click Save and then Close.
8 Maintenance and Migration

Performance Tuning for Analytics and Reports: Points to Consider

When you create analytics and reports, don’t use blind queries and include sufficient filters when creating analytics or reports with hierarchies.

Blind Queries
Avoid blind queries because they are performed without filters and therefore fetch large data sets. Performance could be an issue with these queries and can easily overload the application. All Transactional Business Intelligence queries on large transaction tables must be time bound. For example, include a time dimension filter and additional filters to restrict by key dimensions such as worker. In addition, apply filters to columns that have database indexes in the transaction tables. This ensures a good execution plan is generated for the Business Intelligence query.

Hierarchies and Trees in Transactional Business Intelligence
Queries on trees and hierarchical dimensions such as manager can have an impact on performance. Transactional Business Intelligence uses a column-flattening approach to quickly fetch data for a specific node in the hierarchy. Still, because there is no pre-aggregation for the different levels of the hierarchy, carefully craft any query involving hierarchies to ensure that sufficient filters are applied to keep the result set small.

Reviewing SQL Statements Used in Analyses: Procedure

You can review logical and physical SQL statements using either of the following procedures.

Logical and Physical SQL
Logical SQL is non-source specific SQL that is issued to the Oracle BI Server for an analysis. Logical queries use column names from the Presentation Layer in the repository (RPD) metadata. Based on the logical request, the BI Server issues optimized source-specific SQL to the actual data sources in the Physical Layer of the repository metadata. If you have proper administrative privileges, you can review both logical and physical SQL for analyses.

Using Analysis in Edit Mode

1. Open the analysis in Edit mode and click the Advanced tab.
2. In the SQL Issued section, review the logical SQL statement.

Using Administration Page

1. On the Administration page, in the Session Management section, click the Manage Sessions link.
You must be a Business Intelligence Administrator to access the Administration and Manage Sessions page.

2. On the Manage Sessions page, in the Action column, click the View Log link to review the SQL statement.

Moving Analyses and Reports: Procedure

You can archive to bundle the entire catalog, specific folders, or multi component objects as a .catalog file and upload the .catalog file to unarchive the data to another location in the catalog. Use the archive process to transfer specific data across environments, for example from a development environment to a production environment.

Creating an Archive

To create an archive:

1. Locate the object in the catalog.
2. Select More and then select Archive.
3. In the Archive dialog box, select one or more of the following options:
   - Keep Permissions: Maintain the object or folder’s existing permissions. If you do not select this option, then the archiving process does not include any permissions. Upon unarchiving, the parent folder’s permissions are assigned to all of the objects and folders.
   - Keep Time stamps: Maintain the Creation Time, Last Modified, and Last Accessed times assigned to the object or folder. Upon unarchiving, the LastModified time is updated to indicate the time at which the object or folder is unarchived. If you select this option, the Old option in the Paste Overview area of the Preferences dialog box is available when unarchiving. You use the Old option to overwrite existing catalog items that are older than the catalog items in the archive. If you do not select this option, then the archiving process does not include time information and the Old option in the Paste Overview area of the Preferences dialog box is not available.
4. Click OK to download the archive file.

Moving a File to a New Location

To unarchive a file:

1. Select the folder in the catalog where you want to upload the archived file.
2. In the Tasks pane click Unarchive.
3. In the Unarchive dialog box, browse for and select the archive file.
4. Use the Replace option to specify whether to replace an existing folder or object with the same name.
   - All: Select this option to replace any existing folders or objects with the same names as folders or objects included in the archive file that you are uploading.
   - Old: Select this option to replace folders or objects except those folders or objects that exist, unless they are older than the source.
   - None: Select this option to add any new folders or objects, but preserve any existing folders or objects.
   - Force: Select this option to add and replace all folders or objects.
5. Use the ACL option to specify how the folders or objects are assigned permissions using Access Control Lists (ACLs) when unarchived.
   
   - Inherit: Inherits the folder or object’s permissions (ACL) from its new parent folder.
   - Preserve: Preserves the folder or object’s permissions (ACL) as it was in the original, mapping accounts as necessary.
   - Create: Preserves the folder or object’s permissions (ACL) as it was in the original, creating and mapping accounts as necessary.

6. Click **OK**.
Glossary

**analysis**
A selection of data displayed in one or more views, such as a table or chart, to provide answers to business questions.

**analytics**
Business intelligence objects such as analyses and dashboards that provide meaningful data to help with decision making.

**briefing book**
A collection of static or updatable analyses or dashboard pages that you can download, print, and share with others.

**business intelligence catalog**
The repository where all business intelligence objects, including analyses, reports, briefing books, and agents, are stored. The catalog contains separate folders for personal, shared, and modified objects.

**business intelligence repository**
The metadata that determines all of the columns, or pieces of data, that you can include in analytics. You can also use the repository as a source of data for reports.

**configuration**
A change to the predefined artifacts of the application. Configurations impact multiple users.

**dashboard**
A collection of analyses and other content, presented on one or more pages to help users achieve specific business goals. Each page is a separate tab within the dashboard.

**data model**
The metadata that determines where data for a report comes from and how that data is retrieved.

**desktop page**
A page that’s optimized for extended periods of use with monitors.

**EDI**
Abbreviation for electronic data interchange.

**EFT**
Acronym for Electronic Funds Transfer. A direct transfer of money from one account to another, such as an electronic payment of an amount owed a supplier by transferring money from a payer’s disbursement bank account into the supplier’s bank account.
**flexfield**
A flexible data field that you can configure such that it contains one or more segments or stores additional information. Each segment has a value and a meaning.

**flexfield segment**
An extensible data field that represents an attribute and captures a value corresponding to a predefined, single extension column in the database. A segment appears globally or based on a context of other captured information.

**global header**
The uppermost region in the user interface that remains the same no matter which page you’re on.

**job definition**
The metadata that determines what a job does and what options are available to users when they submit the scheduled process. A job is the executable for a scheduled process.

**panel tab**
A tab that provides supplemental information or functionality for the page. Each panel tab is on the right side of the page, has an icon as the tab label, and slides out when you open the tab.

**personalization**
A change that users make to control the look or behavior of the application. Personalizations impact only the user making the change.

**prompt**
A parameter that you set when you use analytics, limiting the data in the analysis or in all analyses on the dashboard or dashboard page (tab).

**regional area**
The collapsible region in the work area that lets you control what’s in the local area, for example by selecting a task or running a search.
report
An output of select data in a predefined format that's optimized for printing.

role
Controls access to application functions and data.

scheduled process
A program that you run to process data and, in some cases, generate output as a report.

Style template
An .rtf template containing style information that's applied to report layout templates to achieve a consistent look and feel across reports.

subject area
A set of columns, or pieces of data, related to a specific business object or area.

Subtemplate
An .rtf or .xsl format that is defined once and used multiple times within a single report layout template or across multiple layout template files.

view
A specific way to present the results of an analysis, for example as a table or graph. Other types of views, such as the title view, show other components of the analysis.

work area
A set of pages containing the tasks, searches, and other content you need to accomplish a business goal.

workflow
An automated process that passes a task from one user (or group of users) to another to view or act on. The task is routed in a logical sequence to achieve an end result.